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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our 
employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at 
solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. 
Our employees truly care about doing a great job and delivering a high quality customer experience every day. This 
code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in times of 
company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
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Third Party Licenses
XPression INcoder makes use of FFmpeg licensed under the LGPLv2.1 and its source can be downloaded here.

FFmpeg was configured with the following options:

---pkg-config=pkg-config --pkg-config-flags=static 
--extra-version=ffmpeg-windows-build-helpers 

--disable-debug --disable-w32threads --arch=x86 --target-os=mingw32 
--cross-prefix=/root/src/sandbox/cross_compilers/mingw-w64-i686/bin/i686-w64-mingw32 

--enable-gray --enable-libopus --enable-libsnappy --enable-libsoxr --enable-libtheora 

--enable-libvorbis --enable-libwebp --enable-libzimg --enable-libopenjpeg 

--enable-libopenh264 --enable-libxml2 --enable-libdav1d --enable-cuda-llvm 

--enable-libvpx --enable-nvenc --enable-nvdec --extra-libs=-lm --extra-libs=-lpthread 

--extra-cflags=-DLIBTWOLAME_STATIC --extra-cflags=-DMODPLUG_STATIC 
--extra-cflags=-DCACA_STATIC 

--disable-amf --enable-libmfx --enable-avresample --extra-cflags='-mtune=generic' 

--extra-cflags=-O3 --enable-shared --disable-static 
--prefix=/root/src/sandbox/win32/ffmpeg_git_lgpl_n4.3.2_shared 

A patch of changes to FFMPEG 4.3.2 is available in the downloaded source as xpvc_win.patch.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its XPression systems to be free from defects under normal use and service for 
the following time periods from the date of shipment:

• XPression Server — 12 months

• XPression Software Upgrades — 12 months free of charge

• System and Media hard drives — 12 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined 
solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. 
Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are 
expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your XPression 
system, contact your regional sales manager.

https://documentation.rossvideo.com/files/FFmpeg/FFMPEG_XPVC_10.5.tgz
https://documentation.rossvideo.com/files/FFmpeg/FFMPEG_XPVC_10.5.tgz


Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of 
natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious 
manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.



Company Address
Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office:

Fax:

(+1) 613  652  4886

(+1) 613  652  4425

Toll Free Technical Support: 1-844-652-0645 (North America)

+800 1005 0100 (International)

Alternately, you can contact:

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail for Technical Support: techsupport@rossvideo.com

E-mail for General Information: solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
Pre-rolls are a thing of the past with XPression Clips, a production clip server for live production that incorporates the 
latest advances in IT technologies. Built on the industry-leading XPression real-time graphics platform, XPression 
Clips offers you instant recall times and back-to-back clip transitions from an intuitive user interface or via automation 
triggers from other devices like Ross Video productions switchers. 

You can simultaneously ingest multiple channels of baseband video and output multiple channels of clips to air. Both 
NAS and SAN configurations are available for attached storage, in addition to ample local hard drive space. 
Database management and synchronization are possible with the Clip Store that supports user rights and roles. 

You can also add XPression Clips functionality to XPression Studio’s basic clip handling capabilities by adding the 
XPression Clips Option.

Key features of XPression Clips and the XPression Clips Option include:

• Multi-channel ingest and playout

• 1, 2, or 4 channels of baseband video ingest

• 2 or 4 channels of playout (user-definable fill/fill or fill/key configuration)

• Back-to-back transitions

• Multiple clips on the same output

• Clip Browser with searching

• Clip trimming and looping

• VDCP, AMP, PBus, and RossTalk automation protocols

• PBus Manager for intelligent clip assignment

• Clip Manager application with user rights for database management and synchronization setup

• NAS or SAN attached storage with SNS storage (Studio Network Solutions)

Streamline your production clips workflow with Ross Video’s next-generation production clip servers and transcoding 
applications. Available in multiple configurations, XPression Clips/XPression Clips Option and the Clip Server Option 
for XPression Studio bring lightning-fast recall speeds, baseband video ingest, and multi-layer clip playback to the 
control room.
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About This Guide
This user guide describes the XPression Clips workflow, its configuration, and functions.

If, at any time, you have a question pertaining to the installation, configuration, or operation of the XPression Clips 
tools, please contact us at the numbers listed in the section “Contacting Technical Support” on page 1–2. Our 
technical staff are always available for consultation, training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and submenus that must be followed to reach a particular command.

Getting Help
The XPression Clips User Guide is supplied as a print-ready PDF file. Locate the guide in the C:\Archive folder to 
open a guide PDF in Adobe® Reader® for viewing or printing.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (eastern time), technical 
support personnel are available by telephone any time. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, a 
voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to 
any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: 

› 1-844-652-0645 (North America)

› +800 1005 0100 (International)

• After Hours Emergency: (+1) 613-349-0006

• E-mail: techsupport@rossvideo.com

• Website: http://www.rossvideo.com

Bold text Bold text is used to identify a user interface element such as 
a dialog box, menu item, or button.

For example:

In the 3D Model Files section, use the Mode list to select the 
folder used to store 3D model files.

Courier text Courier text is used to identify text that a user must enter.

For example:

Enter localhost when the DataLinq server is running of the 
same computer as XPression.

> Menu arrows are used in procedures to identify a sequence 
of menu items that you must follow. 

For example, if a step reads “Display > Widgets,” you would 
click the Display menu and then click Widgets.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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XPression Clips Components 
and Workflow Overview
The following components of the XPression Clips workflow are discussed in this section:

• XPression Clip Store

• XPression

• XPression Media Control Gateway

• XPression INcoder

• Clips Workflow
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XPression Clip Store
The XPression Clip Store is a windows service that serves as the database to hold clips within a clip workflow. The 
database contains pointers to the clips on disk as well as all of the metadata associated with a clip, such as the 
name, recall ID, in/out points, sub clip info, etc.

The XPression Clip Store can run on any physical machine, but in the basic workflow would generally run on the 
XPression machine itself.

The XPression Clip Store has the capability to replicate clips and metadata to other clip stores in the workflow. For 
example, if you have several XPression machines and run a local Clip Store on each, then those clip stores can be 
kept up to date through automated database/clip syncing. Syncing can also be used to create a backup Clip Store to 
use if the primary machine is taken offline (there is no automatic failover).

The XPression Clip Store has users and user rights assignment features to allow users to be created with 
permissions to perform different tasks such as trimming, deletion, sync, and administration.

XPression Clip Store Manager

The XPression Clip Store Manager is a user application that connects to the Clip Store service (on a local or remote 
machine). The Clip Store Manager is used to administer the users, synchronization settings, and clips.

Extensive search capabilities for browsing the clips is provided and clips can be deleted from the Clip Store Manager.

XPression
The following components are used in the Clips workflow.

If using the XPression Clips Option, the following components are accessed in the XPression Sequencer mode, with 
the exception of the Record Client, which can be accessed in the Layout mode as well.

Clip Browser

The Clip Browser is a window in the XPression Sequencer used for dragging and dropping clips into the Sequencer 
or Server Channels.

Server Channels

The Server Channels window is located in the XPression Sequencer and is used for previewing and playing out clips. 
Clips can also be edited from the Server Channels window.

These channels represent a server channel as on a typical video server. The virtual channels are created in the 
Server Channels tab of the Hardware Setup in XPression.

Clip Editor

From the Clip Browser or the Server Channels, a selected clip can be opened in the Edit Clip window for editing.

PBus Mapping

A PBus Mapping menu exists in the XPression Sequencer to provide additional capabilities to the PBus recall 
system. By assigning a PBus device ID to a server channel, clips from the Clip Browser can be assigned to a PBus 
register simply by dragging them from the Clip Browser onto a PBus register.

Record Client

Use the Record Client dialog box to record an incoming SDI video as a video file or as a still image.

Up to four streams can be recorded simultaneously, however, each stream affects overall system performance, so 
with four streams recording it is unlikely you will be able to playback graphics simultaneously without dropping 
frames. Recording to network locations (NAS/SAN) may or may not be possible depending on the bandwidth 
available. The number of audio channels to record can be varied between 0 and 16. Recordings are made to the 
XPression Video Codec avi format.
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XPression Media Control Gateway
The XPression Media Control Gateway is used to receive AMP or VDCP connections to control XPression with 
XPression Clip Store. AMP/VDCP can be received over either TCP or Serial (RS232) connections.

For RS422 support, an external converter must be used.

One Media Control Gateway is required for each XPression machine.

This gateway connects directly to an XPression machine, but also connects to the XPression Clip Store to retrieve 
the entire clip list.

XPression INcoder
 The XPression INcoder is a separate, optional component to the XPression Clips workflow. For more information, 

or to purchase the INcoder, contact Ross Video.

The XPression INcoder is a windows service that manages one or more watchfolders used for file based ingest of 
clips into the XPression Clips workflow. The INcoder performs transcoding functions to convert clips from compatible 
formats into XPression Codec AVI files. The same formats supported by the XPression Video Coder can be 
transcoded by the INcoder.

For More Information on...

• the XPression INcoder, refer to the XPression INcoder User Guide.
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Clips Workflow
The following diagrams illustrate examples of the XPression Clips workflow options:

• Clips Configuration with Synchronized Clip Store Databases

• Clips Workflow Using the Record Client

• Clips Workflow Using the XPression INcoder

• Clips MOS Workflow

Clips Configuration with Synchronized Clip Store Databases

The following diagram illustrates an example of the XPression Clips workflow setup using synchronized Clip Store 
databases in a non-MOS workflow.

Figure 2.1  Clips Workflow Configuration when Using Multiple Workstations and Synchronized Clip Store Databases



XPression Clips Workflow User Guide (v11.0) 2–5

Clips Workflow Using the Record Client

The following diagram illustrates an example of the XPression Clips workflow setup using the Record Client.

Figure 2.2  Clips Workflow Configuration when Using a Single Engine and the Record Client

Clips Workflow Using the XPression INcoder

The following diagrams illustrate examples of the XPression Clips workflow setup using multiple engines on the 
XPression INcoder server and using a customer supplied PC.

Figure 2.3  Clips Workflow Configuration when Using Multiple Engines and the INcoder Server
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Figure 2.4  Clips Workflow Configuration when Using Multiple Engines and the INcoder on a Customer Supplied PC

Clips MOS Workflow

The following diagram illustrates an example of the XPression Clips workflow setup using synchronized Clip Store 
databases in a MOS workflow.

Figure 2.5  Clips Workflow Configuration when Using Multiple Workstations and Synchronized Clip Store Databases in a 
MOS workflow
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XPression Clip Store Setup
The following topics are discussed in this section:

• Install the XPression Clip Store

• XPression Clip Store Manager Interface Overview

• Starting XPression Clip Store

• Starting the Clip Store Manager

• Configuring the Clip Store

• Configure User Roles

• Configure Users

• Synchronizing Multiple Clip Stores

• Viewing the Transfer Status When Syncing Servers

• Browsing and Deleting Clips

• Projects

• Wiping the Clips Database

• Configure XPression Studio, BlueBox, and Gateway for XPression Clip Store
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Install the XPression Clip Store
Once XPression has been installed, use the following procedure to install the XPression Clip Store:

1. Locate and double-click the xpClipStore-X.X_XXXX.exe file.

The Setup - XPression Clip Store window opens.

2. Click Next.

The Select Destination Location section opens.

3. Use the default destination folder location or click Browse to locate and select a different destination location.
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4. Click Next.

The Select Components section opens.

5. Click Next.

The Select Start Menu Folder section opens.

6. Use the default Start menu folder location or click Browse to locate and select a different Start menu location.

7. Click Next.

The Ready to Install section opens.
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8. Click Install.

The installation begins. Once the installation is complete, the Completing the XPression Clip Store Setup 
Wizard section opens.

9. Click Finish.

If the Start Clip Store service check box is left as selected by default and the installation was successful, an 
information box is displayed that indicates that the XPression Clip Store was successfully started.

For More Information on...

• installing XPression, refer to the XPression Quick Start guides.
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XPression Clip Store Manager Interface Overview
The following screen capture displays the main elements of the XPression Clip Store Manager.

1) Menu Bar — use this menu bar to access the Server 
menu.

2) Object Browser — use this area to browse clips, select 
a project, add users, define user roles, add servers in 
which to sync, and view the status of transfers.

3) Main Window — use this window to configure or edit 
the selected item from the Object Browser.

4) Status Area — displays the current connection status of 
the Clip Store.

1

2

3

4
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Starting XPression Clip Store
XPression Clip Store services are automatically started after installation. However, if the option to start after install is 
de-selected or if the service has been stopped at any point, use the following procedure to start the Clip Store 
service.

Start the Clip Store

1. On the machine that has the XPression Clip Store installed, locate the XPression Clip Store folder using the 
Start menu.

2. Select Start Clip Store ( ).

If the Clip Store has successfully started, an information message indicates that the XPression Clip Store was 
successfully started.

To stop the Clip Store:

1. On the machine that has the XPression Clip Store installed, locate the XPression Clip Store folder using the 
Start menu.

2. Select Stop Clip Store ( ).

If the Clip Store has been successfully stopped, an information message indicates that the XPression Clip Store 
was successfully stopped.
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Starting the Clip Store Manager
Use the XPression Clip Store Manager to connect to XPression Clip server.

1. On the machine that has the XPression Clip Store installed, locate the XPression Clip Store folder using the 
Start menu.

2. Locate the XPression Clip Store folder using the Start menu and select Clip Store Manager.

The Connect to Clip Store server dialog box opens.

3. In the Server section, use the Host box to enter the IP address of the Clip Store service if using remotely. If 
using the Clip Store service locally, select localhost from the list.

This is the server from which the clips will be synchronized.

4. In the Login section, use the User Name box to enter the login name of the user. The default user name is 
admin.

5. Use the Password box to enter the password for the user. The default password is admin.

Select the Save password check box to automatically enter the login credentials for subsequent connections to 
the Clip Store server.

6. Click OK.

The XPression Clip Store Manager opens.
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Configuring the Clip Store
In the XPression Clip Store Manager, use the Server Settings settings section to configure the server details.

1. In the Server Settings section:

a. Use the Storage Folder box to enter a file path for the folder where clips are stored. The default file path is 
D:\ClipStore\Storage.

If the machine does not use a D:\ media drive, the default path will be C:\Program Files 
(x86)\XPression Clip Store\Storage\.

 If this value is being changed after clips have already been ingested into the system, you will need to manually 
copy the contents of the D:\ClipStore\Storage to the new folder. A warning will be presented to remind you 
to do so:

The new path should contain three subfolders: Clips, Thumbnails, and Flipbooks.

The Clip Store must be restarted after changing the storage folder location.

b. Use the TCP Port box to enter or select the port number for the Clip Store server connection. The default is 
9595.

2. In the Recall ID Options section:

a. Select the Allow same Recall ID to be used in different projects check box to use the same recall ID of a 
clip throughout different projects. If selected, the On duplicate recall ID list will adjust to indicate (in same 
project).

When syncing between Clip Stores, all systems must have this option configured identically.

b. Use the On duplicate recall ID list to select an option for handling incoming clips with a duplicate recall ID:

• remove recall ID from existing clip — remove the recall ID from the clip already stored on the server.

• delete existing clip when it has no subclips — delete a duplicate clip from the server if it has had no 
subclips created from it.

• delete existing clip and subclips — delete a duplicate clip and its subclips from the server.

3. In the General Server Information section:

a. Use the Name box to enter a name for the Clip Store server, if necessary. The default name is XPression 
Clip Store.

b. Use the Location box to enter the name of the location where the Clip Store server is located, if necessary.

c. Use the Description box to enter a brief descriptor for the Clip Store server, if necessary.

4. In the HTTP Server section:

a. Select the Enable HTTP Server check box to enable an HTTP server that provides a REST interface for 
retrieving clip information from the Clip Store.

b. Use the HTTP Port box to enter or select the port number for the connection. The default is 9550.

c. Select the HTTPS / SSL check box to use HTTPS / SSL. This requires a pre-installed SSL certificate.

When HTTPS / SSL is enabled, the port number is fixed to 9444.

5. Click OK to apply the Clip Store settings.
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Configure User Roles
Use the XPression Clip Store Manager to create user roles to allow and disable specific functions for specific roles 
that are assigned to users.

1. Connect to the XPression Clip Store Manager.

2. In the Object Browser, select User Roles from the Clip Store menu tree.

The User Roles section opens in the main window.

An Administrator role already exists by default.

3. Right-click inside the User Roles list and select New from the shortcut menu.

The New User Role dialog box opens.

4. In the New User Role box:

a. Use the Name box to enter a name for the new user. For example, if a user is being given deletion rights, a 
user role could be given the name ‘Delete’.

b. Use the Description box to enter a brief descriptor for the user, if necessary.
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c. In the Rights section, use the check boxes to select the rights allowed for the user role:

• Trim — this feature will be available in a future release.

• Delete — ability to delete clips.

• Sync — ability to synchronize servers.

Sync users also require delete rights if deletes are to be synchronized across Clip Stores.

• Administrator — ability to access all rights.

5. Click OK.

The new user role is added to the User Roles list.

Repeat steps 3 to 5 for any other new roles.
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Configure Users
Use the XPression Clip Store Manager to create users to assign to specific user roles that allow and disable specific 
functions.

1. Connect to the XPression Clip Store Manager.

2. In the Object Browser, select Users from the Clip Store menu tree.

The Users section opens in the main window.

An Admin user already exists by default.

3. Right-click inside the Users list and select New from the shortcut menu.

The New User dialog box opens.

4. Use the User tab of the New User box to do the following:

a. In the Credentials section, use the Login box to enter a login credential for the new user.

b. Use the Password box to enter a password for the new user.

Re-enter the password in the Verification box.

c. In the Information section, use the Name box to enter the name of the new user. A name must be entered 
to create a new user.
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d. Use the Department box to enter the name of the department of the new user, if necessary.

e. Use the Email box, enter the email address of the new user, if necessary.

f. Use the Phone box to enter the phone number of the new user, if necessary.

g. Use the Description box to enter a brief descriptor for the user, if necessary.

5. Click the Roles tab.

The Roles tab opens.

6. In the Roles tab, perform the following:

a. Select a role in the Available Roles list.

b. Click Assign.

The role is added to the User Assigned Roles list.

Repeat steps a to b for any other available roles, if necessary.
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7. Click OK.

The new user is added to the Users list.

Repeat steps 3 to 7 to add more new users.

For More Information on...

• creating user roles, refer to “Configure User Roles” on page 3–9.

• configuring API, refer to “Clip Store API” on page 8–1.
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Synchronizing Multiple Clip Stores
Use the Sync Servers section to synchronize multiple Clip Stores. Synchronizing multiple Clip Stores will ensure that 
any changes and edits to a clip, or sub-clips created from a clip, will be reflected across all Clip Stores that have been 
synced.

1. Connect to the XPression Clip Store Manager.

2. In the Object Browser, select Sync Servers from the Clip Store menu tree.

The Sync Servers section opens in the main window.

3. Set up the server to which clips will be synchronized. A sync server is a server that has clips pushed to it.

a. Right-click inside the Sync Servers list and select New from the shortcut menu.

The New Sync Server dialog box opens.
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b. In the New Sync Server dialog box, set up the server from which the clips will be synchronized:

• Name — enter the name of the sync server. The default name is Sync Server.

• Host — enter the IP address of the sync server.

• Port — enter the port number of the sync server. The default is 9595.

• Login — enter the login username for the sync server.

• Password — enter the login password for the sync server.

• Description — enter a brief descriptor for the sync server, if necessary.

• Enabled — select this check box to activate the individual sync server. This is enabled by default.

• Skip Deleted Clips — select this check box to skip deleted clips when synchronizing.

• Continue On Failure — select this check box to continue clip sync after a clip fails to sync.

c. In the Project Filter section, select the Sync All Projects check box to sync all projects to a destination Clip 
Store or de-select it to choose specific projects to sync to a destination Clip Store. It is selected by default.

Click the Check All button to select all projects in the project list. Click the Uncheck All button de-select all 
projects in the project list.

d. Click OK.

The New Sync Server dialog box closes and the new sync server is added to the Sync Servers list.

Repeat step 3 to synchronize other servers, if necessary.

For More Information on...

• connecting to the XPression Clip Store server, refer to “Starting the Clip Store Manager” on page 3–7.

• viewing the transfer status when syncing servers, refer to “Viewing the Transfer Status When Syncing Servers” 
on page 3–16.
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Viewing the Transfer Status When Syncing Servers
Use the Transfer Status section to view the current progress when synchronizing Clip Stores.

Open it by selecting Transfer Status from the Clip Store menu tree in the Object Browser.

 The transfer of files can take awhile depending on the amount of files.

Receiving Files On a Synced Server

When receiving files from a server, the Receiving File list will display the files as they are transfered:

Only one file at a time is listed. The following file information is displayed:

• Receiving File (read-only) — displays the name of the file being received.

• Size (read-only) — displays the file size of the file being received.

• Progress (read-only) — displays a progress status bar and percentage completed for the file being received.

• Speed (read-only) — displays the speed of the download in MB/s.

• Server (read-only) — displays the IP address of files received.

During the incoming transfer, the Outgoing Sync Engine section will display the Engine Status as Idle.
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Outgoing Files from a Clips Server

When files are being pushed to a synced server, the Outgoing Sync Engine section displays the outgoing file 
transfer progress:

The following information is displayed:

• Engine Status (read-only) — displays the current status of the outgoing sync engine:

› Idle — the outgoing sync engine is not currently processing any files.

› Syncing — the outgoing sync engine is processing a file.

• Server (read-only) — displays the name and address of the server being synchronized.

• Files Remaining (read-only) — displays the remaining number of files to be synchronized.

• Speed (read-only) — displays the speed in MB/s of the file processing.

• Current File (read-only) — displays the name of the file being processed.

• File Size (read-only) — displays the size of the file being processed.

• File Progress (read-only) — displays a progress status bar and percentage completed for the file being 
processed.
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Browsing and Deleting Clips
Use the Clips section to browse and delete clips from the server.

Open it by selecting Clips from the Clip Store menu tree in the Object Browser.

Use the Clips list to browse for specific clips, view the clip details, and delete clips from the server.

To delete a clip from the list, right-click a clip and select Delete from the shortcut menu.

Clips List

The following section describes the Clips list interface.

# (read-only) — list number in the Clip Browser list.

Name (read-only) — lists the name of the clip.

In Point (read-only) — lists the drop frame timecode starting point for the clip.

Out Point (read-only) — lists the drop frame timecode ending point for the clip.

Length (read-only) — lists the drop frame timecode duration of the clip.

Format (read-only) — lists the formatting used for the clip.

Thumbnail (read-only) — provides a thumbnail image of the clip or still. Thumbnails can be enlarged by clicking and 
dragging the right border of the thumbnail column title. Review a flip book playout of the clip by hovering the cursor 
over the thumbnail. The flip book is rendered over a checkerboard pattern so that the alpha channel is visible unless 
the clip is full frame. Still image thumbnails display an icon ( ) indicating that they are still images and not clips.

Flags (read-only) — if using clips that have been transcoded by the XPression INcoder that include tags in the 
filename, this column lists the tags that have been parsed from the filename of the clip. The possible flags include:

• LE — indicates that looping has been enabled.

• HF — indicates that the clip will hold the last frame.

• PM — indicates that the clip uses premultiplied/shaped video.

Audio Ch (read-only) — lists the amount of audio channels embedded in the clip.

Bit Depth (read-only) — lists the quality of the signal quantization for the clip.

Recall ID (read-only) — lists the ID number for the clip when it is recalled.
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Project (read-only) — lists the name of the project to which the clip has been added.

Added (read-only) — lists the date the clip was added to the project.

Expires (read-only) — lists the expiry date for the clip, if applicable.

Codec (read-only) — lists the codec format of the clip.

File Ext (read-only) — lists the file type of the clip.

Source (read-only) — lists the location on the server where the clips are stored.

File Size (read-only) — lists the file size of the clip in MB.

Unique ID (read-only) — lists the unique identification assigned to the clip when it was transcoded.

Alpha (read-only) — provides a thumbnail of the clip with the alpha channel visible (if the original status indicates 
<no info>, then re-ingest the original clip or update the thumbnail in the Edit Clip/Add Sub Clip dialog box).

First Frame TC (read-only) — lists the timecode at the point of the first frame of the clip.

Volume (read-only) — lists the volume level of the clip in decibels.

Has Proxy (read-only) — lists whether the clip includes a proxy or not.

Search

The following section describes the Search interface of the Clips section.

Name — use this box to enter the name of a clip to search.

Recall ID — use this box to enter a recall ID to search.

Source — use this box to enter a location to search for a clip.

Duration Min — use this box to enter a minimum duration time to search for the clip.

Duration Max — use this box to enter a maximum duration time to search for the clip.

Project — use this list to select a project to search for the clip.

Added Min — use the calendar to select a minimum date to search that the clip was added.

Added Max — use the calendar to select a maximum date to search that the clip was added.

Expires Min — use the calendar to select the minimum expiry date to search for the clip.

Expires Max — use the calendar to select the maximum expiry date to search for the clip.

Never Expires — select this check box to search for a clip with no expiry date set.

Audio Ch Min — use this box to enter or select a minimum amount of embedded audio channels to search for the 
clip.

Audio Ch Max — use this box to enter or select a maximum amount of embedded audio channels to search for the 
clip.

No Audio — select this check box to search for a clip with no embedded audio.

Reset — click this button to clear all the fields in the Advanced Search Options.

Show all sub clips for matching clips — select this check box to display any sub clips of a clip in the Clips list.
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Projects
Use the Projects section to create, edit, and delete projects.

Open it by selecting Projects from the Clip Store menu tree in the Object Browser.

To create a new project:

1. Right-click inside the Projects list and select New Project from the shortcut menu.

The New Project dialog box opens.

2. Use the Name box to enter a name for the new project.

3. Click OK.

The new project is added to the Projects list.

To edit a project:

1. Right-click inside the Projects list and select Edit Project from the shortcut menu.

The Edit Project dialog box opens.

2. Use the Name box to edit the name of the project.
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3. Click OK.

The edited project name is updated in the Projects list.

To delete a project:

1. Right-click inside the Projects list and select Delete Project from the shortcut menu.

A warning prompt opens.

2. Click Yes.

The project is deleted from the Projects list.

Projects List

The following section describes the Projects interface.

# (read-only) — list number in the Projects list.

Name (read-only) — lists the name of the project.

Number of Clips — displays the number of clips in the project.
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Wiping the Clips Database
If the clips database needs to deleted, there is an option in the Clip Store Manager to permanently wipe the clips 
database.

To permanently wipe the clips database:

1. Connect to the XPression Clip Store Manager.

2. Select Server > Advanced > Wipe clips and database.

A confirmation prompt opens.

3. Click Yes.

A notification about the deletion opens.

4. Click Yes.

The Clips database is wiped.
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Configure XPression Studio, BlueBox, and Gateway 
for XPression Clip Store
Once XPression Clip Store has been configured using the Clip Store Manager, depending on the workflow, the 
following need to be set up for use with the Clip Store:

• XPression Studio

• XPression BlueBox

• XPression Gateway

XPression Studio

1. Open XPression.

2. In XPression, click Edit > Clip Store Setup.

The Clip Store Setup dialog box opens.

3. Use the Hostname box to enter the IP address of the Clip Store service if using remotely. If using the Clip Store 
service locally, use localhost (default).

4. Use the Port box to enter or select the port number for the Clip Store server connection. The default is 9595.

5. Click OK.

XPression is now connected to the Clip Store service.

XPression BlueBox

1. Start the XPression BlueBox Service if not already started.

2. In the Windows toolbar, right-click the XPression BlueBox icon ( ) and select Clip Store Setup from the 
menu.

The Clip Store Setup dialog box opens.

3. Use the Hostname box to enter the IP address of the Clip Store service if using remotely. If using the Clip Store 
service locally, use localhost (default).

4. Use the Port box to enter or select the port number for the Clip Store server connection. The default is 9595.

5. Click OK.

XPression is now connected to the Clip Store service.
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XPression Gateway

With a Clip Store configured on the XPression Gateway, the XPression MOS Plugin offers the ability to browse, 
preview, and select clips as MOS items to include in an NRCS running order. It integrates with the XPression output 
and preview engines and the Remote Sequencer.

1. Open the XPression Gateway.

2. In the XPression Gateway, click Gateway > Settings.

The XPression Gateway - Settings dialog box opens.

3. Click Clip Store to configure the Clip Store Server and settings to use XPression Clips in the MOS workflow.

The Clip Store configuration area opens.

4. In the Clip Store Server section, select the Enabled check box to use the Clip Store Server in the MOS 
workflow.

5. Use the Host box to enter the IP address of the Clip Store Server.

6. Use the Port box to enter or select the port number for the Clip Store Server.
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7. Select the Use HTTPS / SSL check box to enable the use of HTTPS/SSL in the HTTP Server configuration. 
Selecting this option requires a pre-installed SSL certificate.

8. Select the Resolve hostname before sending to plugins check box to resolve the ClipStore hostname to an 
IP before being provided to the client plugins.

9. In the Clips Settings section, use the Default Channel list to select the default engine and channel to which the 
clips will be assigned.
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XPression Media Control 
Gateway
This section contains the following topics:

• XPression Media Control Gateway Overview

• Install the XPression Media Control Gateway

• Media Control Gateway Interface Overview

• Opening the XPression Media Control Gateway Settings Dialog Box

• Configuring the General Settings

• Configuring the AMP Settings

• Supported AMP Commands

• Configuring the VDCP Settings

• Supported VDCP Commands
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XPression Media Control Gateway Overview
The XPression Media Control Gateway can be used for cueing and playback of clips and subclips from a Clip Store 
and for cueing and playback of take items from the XPression Sequencer.

The AMP/VDCP channels correspond to the server channels in XPression. The format for the naming of the 
clips/take items can be configured in the XPression Media Control Gateway - Settings dialog box. This format 
must ensure that every item is uniquely identified – duplicates will not be reported in the list of items retrieved by the 
remote device.

Clip and subclip formats support the following tags:

• %NAME% 

• %FILENAME% 

• %ID% 

• %GUID% 

The take item format supports the %ID% tag. Widths can be specified with a colon. For example %NAME:35% to limit 
the name to 35 characters, or %ID:4% to use a 4-digit ID padded with 0s.

VDCP/AMP support basic item cueing, as well as cueing with specific in and out points. Playback support includes 
jog, shuttle, and variable speed playback. VDCP/AMP also support recording of clips, which will be directly added to 
the XPression Clip Store upon a successful record.

The AMP protocol also supports retrieving thumbnails of the clips (when supported by the remote device).

 Deleting and renaming items in the Clip Store or the XPression Sequencer is not supported by the gateway.
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Install the XPression Media Control Gateway
1. Locate and double-click the xpMediaControlGateway-X.X_XXXX.exe file.

The Setup - XPression Media Control Gateway window opens.

2. Click Next.

The Select Destination Location section opens.

3. Use the default destination folder location or click Browse to locate and select a different destination location.
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4. Click Next.

The Select Components section opens.

5. Click Next.

The Select Start Menu Folder section opens.

6. Use the default Start menu folder location or click Browse to locate and select a different Start menu location.

7. Click Next.

The Select Additional Tasks section opens.
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8. Use the default additional tasks configuration or de-select the Create a Startmenu Icon check box (the default 
setting is as selected).

9. Click Next.

The Ready to Install section opens.

10. Click Install.

The installation begins.

Once the installation is complete, the Completing the XPression Media Control Gateway Setup Wizard 
section opens.

11. Click Finish.

If the Run XPression Media Control Gateway check box is left as selected by default, the XPression Media 
Control Gateway launches.
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Media Control Gateway Interface Overview
The following screen capture displays the main elements of the Media Control Gateway interface.

1) File Menu — use this list to access the Media Control 
Gateway settings or shutdown the gateway.

2) Log — displays the activity of the Media Control 
Gateway.

3) Connections — displays the connections and their 
respective status.

1

2

3
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Opening the XPression Media Control Gateway 
Settings Dialog Box
1. Launch the XPression Media Control Gateway.

The XPression Media Control Gateway opens.

2. Click File > Settings.

The XPression Media Control Gateway - Settings dialog box opens.
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Configuring the General Settings
1. In the XPression Media Control Gateway, click File > Settings.

The XPression Media Control Gateway - Settings dialog box opens.

2. In the General tab, configure the following settings as necessary:

a. In the XPression Engine section, use the Host box to enter the IP address of the XPression machine to 
which the gateway is to connect. Or, enter localhost to connect the gateway to the local XPression 
machine. The default setting is localhost.

b. Use the Port box to enter or select the port number of the XPression machine. The default is 8001.

c. In the Misc section, configure the following settings as necessary:

• Start With Windows — select this check box to start the gateway when Windows launches.

• Log Commands — select this check box to log the commands in the gateway.

• Enable TCP Keep Alive — select this check box to prevent the TCP connection from breaking during 
periods of inactivity.

• Log Status Requests — select this check box to log the status requests in the gateway.

d. In the ID / Name Format section, use the Clip ID Format box to enter the format for the naming of the clips 
in the gateway.

e. Use the Sub Clip ID Format box to enter the format for the naming of the subclips in the gateway.

Select the Include Sub Clips check box to include subclips in the clip list. This enabled by default.

f. Use the Take ID Format box to enter the format for the naming of take IDs in the gateway.

Select the Include Take IDs check box to include take IDs from the XPression sequencer in the clip list. This 
is enabled by default.

g. In the Clip Store Filter section, select the Filter Clips By Project check box to only retrieve clips from a 
specified project. Enter a project name in the text box from which to retrieve clips.

h. In the Commands section, select the Prevent the Pause command from forcing clip to output check box 
to prevent the clip from going to output when pause commands are received from a device.

When this check box is selected, the Cue video clips directly to framebuffer check box in the Options tab of 
the Server Channels must not be selected for this preference to function.

3. Click OK.

The XPression Media Control Gateway - Settings dialog box closes.
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Configuring the AMP Settings
1. In the XPression Media Control Gateway, click File > Settings.

The XPression Media Control Gateway - Settings dialog box opens.

2. Click the AMP tab.

The AMP tab opens.

3. Configure the AMP connection settings as required:

AMP Over TCP/IP

a. In the AMP over TCP/IP section, the Server Port box displays the port number for the TCP/IP server 
connection. The default is 3811 and is not user-configurable.

b. Select the Accept AMP CMDS commands with incomplete last byte to accept CMDS commands with an 
incomplete last ASCII byte.
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AMP Over RS232

a. In the AMP over RS232 section, click Add to add a port for the RS232 connection.

The Select RS232 Port dialog box opens.

b. Use the Port list to select a COM port for the connection.

c. Click OK.

The COM port is added to the AMP over RS232 connections list.

d. Configure the connection settings if necessary:

• Port — use the list to select a different COM port if necessary.

• Baudrate — use the list to select a communication speed for GPI signals.

• Data Bits — use the list to select the number of bits used to represent one character of data for GPI 
signals.

• Parity — use the list to select the method used to check for lost data in a GPI signal.

• Stop Bits — use the list to select the number of bits used to indicate the end of a byte in a GPI signal.

• Flow Control — use the list to select the data transmission rate controller for a GPI signal.

• Enabled — use the check box to select whether the AMP over RS232 connection is enabled or not.

• Channel — use the list to select a server channel for playout.

When using TCP/IP, the channel corresponding to the server channel in XPression is specified by the 
remote device when establishing a connection. However, when using RS232, there is no such provision in 
the protocol, so the server channel needs to be specified.

4. In the AMP Recording section, click Add to select a source input if using AMP recording with the Record Client.

The Select Video Channel # dialog box opens.

a. Use the Channel list to select a server channel to use for the AMP session.
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b. Click OK.

The server channel is added to the AMP Recording list.

c. Use the Record Input list to select an input for recording functionality. The default is Input 1.

When the AMP connection is configured to control a certain server channel, if this channel is associated with 
an input, then the AMP session will have playback control on the server channel and record control on the 
input. If the channel is not mapped to an input, then the AMP session will only have playback control.

Successful recordings are automatically added to the Clip Store.

d. Select the Allow RECORD without CUE check box to crash record from AMP when the RECORD 
command is received without the CUE command.

Use the Clip Name box to enter the name of the clip to crash record using the RECORD without CUE 
function.

5. Click OK.

The XPression Media Control Gateway - Settings dialog box closes.
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Supported AMP Commands
Cueing and playback control on output ports of clips in Clip Store and take items in the Sequencer is supported, as 
well as recording on input ports. Clip management, such as renaming, deleting, or modifying clips, is not supported. 
Delayed commands are also not supported. The option to send a list of clips to certain commands (e.g. IN PRESET) 
is not supported.

The following AMP commands are supported by the XPression Media Control Gateway:

• STOP

• PLAY

• RECORD

• EJECT

• FAST FORWARD

• JOG FORWARD/REVERSE

• VARIABLE FORWARD/REVERSE

• SHUTTLE FORWARD/REVERSE

• REWIND

• CUE UP WITH DATA

• IN PRESET

• OUT PRESET

• STATUS SENSE

• CURRENT TIME SENSE

• RECORD CUE UP WITH DATA

• GET THUMBNAIL

• LIST FIRST ID

• LIST NEXT ID

• ID LOADED REQUEST

• ID DURATION REQUEST

• SET RECORD DURATION

• ID START TIME REQUEST

• ID COUNT REQUEST

• DEVICE NAME REQUEST
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Configuring the VDCP Settings
1. In the XPression Media Control Gateway, click File > Settings.

The XPression Media Control Gateway - Settings dialog box opens.

2. Click the VDCP tab.

The VDCP tab opens.

3. Configure the VDCP connection settings as required:

VDCP Over TCP/IP

a. In the VDCP over TCP/IP section, use the Server Port box to enter or select the port number for the TCP/IP 
server connection. The default is 9091.

b. Select the Loop commands check box to use a VDCP extension to turn looping on (0x1X 0xF1) and off 
(0x1X 0xF2). This option is disabled by default.

c. Select the CUE/INIT when CUE/INIT DONE is set check box only if the VDCP controller does not support 
having both the CUE/INIT and CUE/INIT DONE flags asserted simultaneously (playback or record). This 
option is disabled by default.
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VDCP Over RS232

a. In the VDCP over RS232 section, click Add to add a port for the RS232 connection.

The Select RS232 Port dialog box opens.

b. Use the Port list to select a COM port for the connection.

c. Click OK.

The COM port is added to the VDCP over RS232 connections list.

d. Configure the connection settings if necessary:

• Port — use the list to select a different COM port if necessary.

• Baudrate — use the list to select a communication speed for GPI signals.

• Data Bits — use the list to select the number of bits used to represent one character of data for GPI 
signals.

• Parity — use the list to select the method used to check for lost data in a GPI signal.

• Stop Bits — use the list to select the number of bits used to indicate the end of a byte in a GPI signal.

• Flow Control — use the list to select the data transmission rate controller for a GPI signal.

• Enabled — use the check box to select whether the VDCP over RS232 connection is enabled or not.

e. Select the Loop commands check box to use a VDCP extension to turn looping on (0x1X 0xF1) and off 
(0x1X 0xF2). This option is disabled by default.

f. Select the CUE/INIT when CUE/INIT DONE is set check box to only if the VDCP controller does not support 
having both the CUE/INIT and CUE/INIT DONE flags asserted simultaneously (playback or record). This 
option is disabled by default.

4. Click OK.

The XPression Media Control Gateway - Settings dialog box closes.
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Supported VDCP Commands
Cueing and playback control on output ports of clips in Clip Store and take items in the Sequencer is supported, as 
well as recording on input ports. Clip management, such as renaming, deleting, or modifying clips, is not supported. 
Also, timeline and macro commands are not supported.

The following VDCP commands are supported by the XPression Media Control Gateway:

Immediate commands:

• STOP

• PLAY

• RECORD

• STILL

• CONTINUE

• STEP

• JOG

• VAR PLAY

Preset commands:

• CLOSE PORT

• SELECT PORT

• PLAY CUE

• PLAY CUE WITH DATA

• RECORD INIT

Sense commands:

• PORT STATUS

• OPEN PORT

• ID LIST

• ID ADDED LIST

• ID DELETED LIST

• NEXT

• ACTIVE ID REQUEST

• POSITION REQUEST

• ID SIZE REQUEST

• ID REQUEST

• DEVICE TYPE REQUEST
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XPression INcoder
 The XPression INcoder is a separate, optional component to the XPression Clips workflow. If the INcoder has not 

been purchased, use the Record Client feature in XPression to transcode clips. For more information, or to 
purchase the INcoder, contact Ross Video.

The following topics are discussed in this section:

• XPression INcoder Overview

• INcoder User Interface Overview

• Configuring the XPression INcoder

• XPression INcoder Tasks
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XPression INcoder Overview
The XPression INcoder is a windows service that manages one or more watchfolders used for file based ingest of 
clips into the XPression Clips workflow. The INcoder performs transcoding functions to convert clips from compatible 
formats into XPression Codec AVI files. The same formats supported by the XPression Video Coder can be 
transcoded by the INcoder. Still images can be exported to the Clip Store in their native format.

After clips have been dropped into a watchfolder, an email based notification system can alert configured users to 
status events such as failures or successful transcodings.

The XPression INcoder Manager is used for managing and configuring the INcoder service. The INcoder Manager 
can run on the INcoder machine or connect to a remote INcoder.

INcoder Terminology

There are several pieces of terminology to understand in the INcoder Manager necessary for configuring it.

• Source — a source represents a watchfolder where clips can be placed to be transcoded. The watchfolder can 
exist on a local or accessible network drive.

• Project — an abstract concept used for grouping clips. A watchfolder should be assigned a project. Examples of 
projects could be: news, sports, weather, etc. Separate watchfolders could be assigned for each project so that 
clips dropped into a particular folder on disk will be assigned the correct project which can later be used for 
searching or clerical tasks. Each project can have separate lists of users to notify.

• Target — a target represents the destination to which the transcoded clip should be sent. In the case of XPression 
Clips, the target would be an XPression Clip Store. After a successful transcode the clip will be sent to all of the 
targets assigned to the processor.

• Processor — a processor represents a collection of targets. Each source (watchfolder) must be assigned a 
processor. After transcoding, all targets in the processor will receive the final clip.

For More Information on...

• the XPression INcoder, refer to the XPression INcoder User Guide.



XPression Clips Workflow User Guide (v11.0) 5–3

INcoder User Interface Overview
This section provides a user interface overview for the XPression INcoder Manager interface.

The following user interfaces are discussed in this section:

• The XPression INcoder - Tasks Tab

• The XPression INcoder - Configuration Tab

The XPression INcoder - Tasks Tab

The following screen capture displays the main elements of the Tasks tab in the XPression INcoder Manager.

1) Menu Bar — use the Manager menu to exit the 
XPression INcoder.

2) INcoder Engines — displays the configured engines for 
the XPression INcoder along with their state and details.

3) Tasks — lists the clips that are transcoded and 
transcoding for specific INcoder engines, as well as the 
details about the transcoding.

4) Task Details — feature currently not implemented.

1

2

3
4
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The XPression INcoder - Configuration Tab

The following screen capture displays the main elements of the Configuration tab in the XPression INcoder Manager.

1) Menu Bar — use the Manager menu to exit the 
XPression INcoder.

2) INcoder Engines — displays the configured engines for 
the XPression INcoder along with their state and details.

3) Configuration Tabs — use the configuration tabs to 
configure the INcoder engines, users, projects, targets, 
processors, and sources.

4) Configuration Area — use the configuration area to 
configure the settings and details for the selected 
configuration tab.

1

2

3

4
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Configuring the XPression INcoder
Use the XPression INcoder Manager to configure the XPression INcoder for use with XPression Clips.

1. On the machine that has the XPression INcoder installed, locate the XPression INcoder folder using the Start 
menu.

2. Select Start INcoder ( ) if the INcoder has not been started.

If the INcoder has successfully started, an information message indicates that the XPression INcoder was 
successfully started.

3. Locate the XPression INcoder folder using the Start menu and select INcoder Manager.

The XPression INcoder Manager opens.
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4. Click the Configuration tab. 

The Configuration tab opens.

5. Configure the configuration tabs from right to left:

Engine

a. Click the Engine tab.

The Engine tab opens.
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b. Click Add.

An engine is added to the Incoder Engines list.

c. In the Engine section, use the Name box to enter a name for the INcoder engine, if necessary. The default 
name is Incoder Engine 1.

d. Use the Location box to enter the name of the location where the INcoder engine is located, if necessary.

e. Use the Description box to enter a brief descriptor for the INcoder engine, if necessary.

f. In the Engine Connection section, use the Host box to enter the IP address of the INcoder service if using 
remotely. If using the INcoder service locally, enter localhost.

g. Use the Port box to enter or select the port number for the INcoder service connection. The default is 9797.

h. In the Mail Server section, use the Login box to enter the user ID for access to the mail server.

i. Use the Password box to enter the password for the login user name.

 Consult your system administrator if you are uncertain of the login credentials.

j. In the Mail Server Connection section, use the Host box to enter the IP address of the mail server.

k. Use the Port box to enter or select the port number for the mail server connection. The default is 25.

l. Use the Sender Name box to enter a name for the sender of notifications regarding the status of INcoder 
tasks.

m. Use the Sender E-Mail box to enter the email address of the originator of the status information.

n. In the Options section, use the Simultaneous Transcodes box to enter or select an amount of video files 
that can be transcoded by the INcoder simultaneously. Any videos beyond this amount will be queued until 
other video files have been transcoded.

 Currently, a maximum of eight simultaneous transcodes is available. However, the number of simultaneous 
transcodes should not be set higher than the number of CPU cores available on the machine.



5–8 XPression Clips Workflow User Guide (v11.0)

o. Click OK to apply the settings.

The engine settings are updated in the Incoder Engines list. If the connection is successful, the State will 
display as Connected.

Users

a. Click the Users tab.

The Users tab opens.
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b. Click Add.

A new user is added to the users list.

c. In the User section, use the Name box to enter a name for the user. The default is New User 1.

d. Use the E-Mail box to enter the email address of the user that is to receive notifications about the INcoder 
statuses.

e. Use the Location box to enter a location of the user, server, etc. For example, Room 01 or a rack room 
name.

f. Use the Phone # box to enter the phone number of the user.

g. Use the Description box to enter a brief descriptor for the user, such as their title or position, etc.



5–10 XPression Clips Workflow User Guide (v11.0)

h. Click OK.

The user details are added to the user in the user list.

Repeat steps b to h for as many users as necessary.

Projects

a. Click the Projects tab.

The Projects tab opens. Projects act as a filter for which users have access to certain clips.
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b. Click Add.

A new project is added to the project list.

c. In the Project section, use the Name box to enter a project name. The default name is New Project 01.

d. Use the Description box to enter a brief descriptor for the project.

e. In the Notify Users on Completed tab, select a user from the Available users list and click Add.

The user is added to the Allocated users list.
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f. Use the Email Template list to select the template that will be used for the outgoing status email. The 
options are:

• <none> — select this option to use no template and receive no email notifications.

• sample-completed.html — select this option to use the sample-completed HTML template for the 
notification.

• sample-failed.html — select this option to use the sample-failed HTML template for the notification. This 
is the default option.

g. Configure the batch notification settings as necessary:

• Notify in batch every — select this check box to notify users of multiple successful transcodes in bulk 
within a specified time interval. Use the minutes box to enter or select a time interval in minutes for the 
notifications.

• Notify in batch when project queue empties — select this check box to notify users of multiple 
successful transcodes once the queue of videos being transcoded in the INcoder Tasks list is empty. Use 
the Batch limit box to enter or select a limit on the amount of ingested files that are included in the batch 
for the notification.

If both of the batch notification options are selected, the queue notification option will still occur even if it 
occurs before the batch notification time interval.

Custom templates can be added to the EmailTemplates folder in the XPression INcoder folder in the 
Program Files folder. The custom templates will then be available in the Email Template menu.

h. Click the Notify Users on Failure tab.

The Notify Users on Failure tab opens.
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i. Select a user from the Available users list and click Add.

The user is added to the Allocated users list.

j. Use the Email Template list to select the template that will be used for the outgoing status email. The 
options are:

• <none> — select this option to use no template and receive no email notifications.

• sample-completed.html — select this option to use the sample-completed HTML template for the 
notification. This is the default option.

• sample-failed.html — select this option to use the sample-failed HTML template for the notification.

k. Configure the batch notification settings as necessary:

• Notify in batch every — select this check box to notify users of multiple successful transcodes in bulk 
within a specified time interval. Use the minutes box to enter or select a time interval in minutes for the 
notifications.

• Notify in batch when project queue empties — select this check box to notify users of multiple 
successful transcodes once the queue of videos being transcoded in the INcoder Tasks list is empty. Use 
the Batch limit box to enter or select a limit on the amount of ingested files that are included in the batch 
for the notification.

If both of the batch notification options are selected, the queue notification option will still occur even if it 
occurs before the batch notification time interval. Fail notifications are sent individually.

Custom templates can be added to the EmailTemplates folder in the XPression INcoder folder in the 
Program Files folder. The custom templates will then be available in the Email Template menu.
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l. Click OK.

The project user settings are applied and the project info in the project list is updated.

Repeat steps b to l for as many projects as necessary.

Targets

a. Click the Targets tab.

The Targets tab opens. Use the Targets tab to configure destinations for the clips.
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b. Click Add.

A new target is added to the targets list.

c. In the Target section, use the Name box to enter a name for the target. The default is New Target 1.

d. In the Details section, use the Type list to select Clip Store in order to send encoded clips from the watch 
folder to the XPression Clip Store Manager.

Use the Host box to enter an IP address for the Clip Store Manager location or use localhost (default) if the 
Clip Store Manager is on the same machine as the INcoder.

Use the Port box to enter or select the port number for the Clip Store Manager location. The default is 9595.

For information about using the Folder type option, refer to the XPression INcoder User Guide.
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e. Click OK.

The settings are added to the target in the targets list.

Repeat steps b to e for as many targets as necessary.

Processors

a. Click the Processors tab.

The Processors tab opens. Use processors to delegate the targets that are used for a source.
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b. Click Add.

A new processor is added to the processors list.

c. In the Processor section, use the Name box to enter a name for the processor. The default is New 
Processor 1.

d. In the Options section, select the Re-encode files that are already in the XPression codec check box to 
force XPression codec files to be re-encoded.

e. In the Targets section, select a target from the Available targets list and click Add.

The target is added to Allocated targets list. Repeat this step for as many targets as necessary.
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f. Click OK to add the processor and its target settings.

Repeat steps b to f for as many processors as necessary.

Sources

a. Click the Sources tab.

The Sources tab opens. Use this tab to add watch folders and assign processors to them.

b. Click Add.

A new source is added to the source list.
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c. In the Source section, use the Type list to select a source type. The only currently available option is Watch 
Folder. Watch folders are where clips are added for encoding.

Select the Enabled check box to use the selected source in the source list.

d. Use the Name box to enter a name for the source. The default is New Source 1.

e. Use the Folder box to enter a file path to a folder or click Browse (...) to select a folder where the INcoder 
will look for files to encode and send to the target.

f. Configure the following options as necessary:

• Use file system change notification — select this check box to have any file changes to the source 
folders reflected in the INcoder immediately.

• Scan for changes every — use this box to enter or select an amount of time in seconds that the INcoder 
scans the source for any changes.

• File size should not change for at least — enter or select an amount in seconds for the INcoder to wait 
before the encoding of a file begins. This is helpful with larger files where transferring might take a little 
longer.

g. Use the Processor list to assign a processor to the selected source. The processor dictates the target of the 
selected source.

h. Use the Project list to assign a project to receive status notifications regarding clips in the selected source.

i. Use the Relative Priority list to assign a priority level to the source folder. The order of priority ranges from 
-5 (low) to 0 (normal) to +5 (high). The default is 0. This is helpful if you have multiple sources, some of 
which are of a higher priority than others. Files from the higher priority sources will transcode before files 
from lower priority sources.

j. In the Parsing Options section, use the File Extension Filter box to enter file extensions accepted for 
transcoding by the INcoder. All file extensions need to listed with an asterisk (*) in front of the file extension 
and a semi-colon (;) between different file types.

Any file extension currently not listed here is not supported by the INcoder. The INcoder currently supports 
MOV, AVI, JPG, PNG, TGA, and TIF files. Any other file type not listed is immediately blocked.

k. In the Recall ID Parsing section, configure the following file options as necessary:

• Treat trailing numbers in filename as Recall ID — select this check box to use any numbers between 
the filename text and the file extension as recall IDs.

If selected, select the Recall ID should be preceded by underscore check box to only use trailing 
numbers in a filename as recall IDs if the numbers are preceded by an underscore.

• When Recall ID is empty, use filename as Recall ID — select this check box to use the filename to 
populate the recall ID field if no other recall ID has been explicitly set.

l. In the Default Clip Store Metadata section, configure the following metadata options for the folder as 
necessary:

• Assume videos are pre-multiplied (shaped) — select this check box to assume that the videos 
multiply/shape the fill signal color information by the luminance information in the key signal.

• Set Looping Attribute — select this check box to enable looped playback on the videos.

• Set “Hold Last Frame” Attribute — select this check box to hold the video on the last frame when 
playout has completed. This is also used to keep still images that are one frame in size on screen.

• Default Frame Rate — use the list to select a frame rate for the video files in the folder.
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 The following tags are parsed from the filenames of files dropped into the watch folder:

• {GP} — Recall ID

• {HF} — Hold Last Frame

• {ID} — Recall ID

• {LE} — Loop Enabled

• {LFF} — Lower Field First

• {NA} — Name

• {PM} — Premultiplied/Shaped video

• {UFF} — Upper Field First

For example, a filename of {NA}Snowstorm{GP}1000{LE}{PM}.mov will be given a name of Snowstorm, a 
recall ID of 1000, and will be set to looped playback with shaped video.

If any of the Assume videos are pre-multiplied (shaped), Set Looping Attribute, or Set “Hold Last Frame” 
Attribute check boxes have been selected and you want to turn off those settings for a particular file, a “FALSE” 
string needs to be added to the tag in the filename. For example, {LE}FALSE.

m. In the Folders section, configure folder destinations as necessary for the clips depending on their status. In 
the file path box, enter a file path to a folder or click Browse (...) to select a folder for the selected folder 
option.

• When queued move to — select this check box to move transcoding files to a selected folder when they 
are queued.

• On failure move to — select this check box to move files to the selected folder if the transcoding has 
failed.

• On cancelled move to — select this check box to move transcoding files that have been cancelled to the 
selected folder.

• On completion — select this check box and choose one of the following options for the files:

› Move — select this option to select a folder to move the files to upon completion of transcoding.

› Delete — select this option to delete the files after transcoding is complete.

• Folder for temporary file processing — select this check box to temporarily move the files to the 
selected folder while transcoding.

 If no folder check boxes are selected and no destination folders assigned, default folders will be created for these 
options.

6. Click OK.

Repeat steps 5 to 6 for as many INcoder engines as necessary.

For More Information on...

• the XPression INcoder, including stopping the INcoder service, refer to the XPression INcoder User Guide.
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XPression INcoder Tasks
Use the XPression INcoder Manager to view the INcoder tasks.

1. On the machine that has the XPression INcoder installed, locate the XPression INcoder folder using the Start 
menu.

2. Select INcoder Manager.

The XPression INcoder Manager opens on the Tasks tab.
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3. Add a video to the source folder.

The video appears in the Tasks list and the State is listed as Transcoding.

Once the video has finished transcoding, the State lists as Finished and the Progress displays at 100.0%.
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If the INcoder shows no tasks in the Tasks list once a video is added to the source folder, verify that the video 
type is supported. If the video type is supported, stop and then restart the INcoder:

a. Select Stop INcoder ( ) from the Windows Start menu.

If the INcoder was successfully stopped, an information message indicates that the XPression INcoder was 
successfully stopped.

b. Select Start INcoder ( ) from the Windows Start menu.

If the INcoder has successfully started, an information message indicates that the XPression INcoder was 
successfully started.

Task List Shortcut Menu - INcoder Engine

Right-click on an INcoder engine in the Tasks list to access the INcoder engine shortcut menu:

• Remove > Completed — select this to remove completed clips from the Tasks list for the selected engine.

• Remove > Failed — select this to remove failed clips from the Tasks list for the selected engine.

• Remove > Cancelled — select this to remove cancelled clips from the Tasks list for the selected engine.

Task List Shortcut Menu - Video

Right-click on a transcoded video in the Tasks list to access the video shortcut menu:

• Set Priority — select this to set a priority level for the selected clip. The order of priority ranges from -5 (Lowest) 
to 0 (Normal) to +5 (High). The default is 0.

• Remove — select this to remove the selected clip from the Tasks list.

• Cancel — select this to cancel an in-progress transcoding of a clip.
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Using XPression Clips
The following topics are discussed in this section:

• Set Up Server Channels

• XPression Clips Playback Overview

• Clip Browser Interface Overview

• Using the Clip Browser

• Server Channels Interface Overview

• Using the Server Channels

• Edit Clip/Add Sub Clip

• Updating the Thumbnail in the Clip Browser

• Creating a 4-Point Loop

• Creating a 3-Point Loop

• Send a Video or Image to Clip Store Using the Record Client

• Preset Event Tracks
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Set Up Server Channels
The Server Channels are used for previewing and playing out clips.

Before using the Server Channels, they must be configured in the XPression Hardware Setup. Once outputs have 
been configured in XPression, use the following procedure to set up the server channels.

A virtual channel should be assigned a real physical output onto which the clip will be played. It is these virtual 
channels that the AMP/VDCP Media Control Gateway is controlling.

This section contains the following information:

• Adding a Server Channel

• Adding a Preview Output to a Server Channel

For More Information on...

• configuring outputs, refer to the XPression User Guide or Help file.

Adding a Server Channel

1. In XPression, click Edit > Hardware Setup.

The Hardware Setup dialog box opens.
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2. Click the Server Channels tab.

The Server Channels tab opens.

3. Click Add to add a server channel.

The Select Server Channel # dialog box opens.

4. Use the Channel list to select a server channel number.

5. Click OK.

The server channel is added to the list.
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6. Configure the following as necessary:

• In the Name column, enter a name for the server channel. The default is Server Channel #.

• In the Framebuffer column, use the list to select an output framebuffer for the server channel.

• In the Layer column, use the list to select a layer for rendering. The default is 0 (middle).

• In the Server Channel # Options section, select the Cue video clips directly to framebuffer check box to 
cue clips to air immediately when dropped on a server channel from the Clip Browser.

7. Repeat steps 3 to 6 to add more server channels as necessary.

8. Click Close.

The Hardware Setup dialog box closes.

Adding a Preview Output to a Server Channel

Once a server channel has been created, it can be assigned a dedicated framebuffer as a preview channel in the 
Preview & Monitor tab of the Hardware Setup. Real outputs can also be used as framebuffers.

1. In XPression, click Edit > Hardware Setup.

The Hardware Setup dialog box opens.



XPression Clips Workflow User Guide (v11.0) 6–5

2. Click the Preview & Monitor tab.

The Preview & Monitor tab opens.

3. Click inside the Assigned Preview Output column of a server channel in the Output list and use the Assigned 
Preview Output list to select a framebuffer as the individual preview output.

The selected framebuffer is assigned as the preview output of the selected server channel.

For More Information on...

• creating a server channel, refer to “Adding a Server Channel” on page 6–2.
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XPression Clips Playback Overview
Clip playback within XPression can be performed in many ways. The most basic is to open the Clip Browser in the 
Sequencer and drag clips from the Clip Browser and drop them into the Sequencer. This creates a take item which 
can be assigned an output framebuffer and layer, or server channel and layer, and then played back as a regular 
take item or placed into a Cued state using the number pad period key [Num pad .].

Regular XPression graphics can be rendered as a clip which will be sent directly to the Clip Store. By right-clicking on 
a take item in the Sequencer and selecting Export Take Item to Video, the Export to Video dialog box will open and 
provide the option to render take items into clips transferred to the clip store.

The number of clips that can be played back simultaneously falls under the same performance limitations as normal 
XPression scenes with clips (e.g. play back will be dependent on current generation hardware).

While playing back, a timer counts down the remaining time in the clip and a time bar indicates the playback amount 
completed:

Many clips can be dragged into a timed sequence group for a pseudo-playlist capability. Dissolves can even be set 
on the take items for transitions between the playlist items:

Clips within the Clip Browser can be sorted and filtered using the options in the Advanced Search Options. In the 
example image below they were filtered by Project Name:



XPression Clips Workflow User Guide (v11.0) 6–7

Clip Browser Interface Overview
The following screen capture displays the main elements of the Clip Browser interface.

1) Sources — use this area to view and select clip 
sources.

2) Quick Find/Search Area — use this area to search for 
clips. It can be expanded for advanced search options.

3) Clips List — use this list to view the clips and their 
multiple properties, cue the clips to the server channels, 
edit clips, and add sub clips.

1

2

3
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Using the Clip Browser
The Clip Browser is used for dragging and dropping clips onto Server Channels or into the Sequencer as take items 
that can then be cued or played out on server channels (instead of a framebuffer). When dragging a clip into the 
Sequencer, the take ID assigned uses the recall ID or the next higher available number. The Clip Browser also allows 
for editing of clips.

If clips have been sent to the Clip Browser from the Record Client, or if clips have been transcoded by the INcoder 
into the Watch Folder, clips will automatically load into the Clip Browser.

Opening the Clip Browser

If using the Clips Option for XPression, use the following procedure to access the Clip Browser.

1. In XPression, open the Sequencer layout.

2. In the Menu bar, click Display > Clip Browser.

The Clip Browser window opens.

Clip Browser Interface

The following section describes the Clip Browser window interface.

All Sources — lists the Clip Store sources.

Settings — use this list to select the following options:

• Increase Font Size ( ) — select this to increase the font size of the Clip Browser list.

• Decrease Font Size ( ) — select this to decrease the font size of the Clip Browser list.

• Timecode > Use Source Timecode for In/Out points — select this to display the In/Out points relative to the 
timecode of the original source clip.

• Show Thumbnail Overlays — select this to overlay an icon on thumbnails of single frame clips in the Clip 
Browser to indicate that they are stills.

• Reset Columns to Default — select this to revert the Clip Browser columns to the default display settings.

Fast Recall — click this button to enable or disable fast recall through the keyboard number pad (the button is green 
when turned on). The number pad Scroll Lock key can also be used to control fast recall.

Quick Find — use this box to enter keywords to search for clips listed in the Clip Browser.

Show/Hide advanced search options ( / ) — click this button to show or hide the Advanced Search Options 
in the Clip Browser.

Reset Filter — click this button to clear any entries in the fields of the Advanced Search Options.

Filter (read-only) — displays the project selected in the Advanced Search Options.

Show all sub clips for matching clips — select this check box to display any sub clips of a clip in the Clip Browser 
list.

# (read-only) — list number in the Clip Browser list.

Name (read-only) — lists the name of the clip.
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In Point (read-only) — lists the drop frame timecode starting point for the clip.

Out Point (read-only) — lists the drop frame timecode ending point for the clip or still.

Length (read-only) — lists the drop frame timecode duration of the clip or still.

Format (read-only) — lists the formatting used for the clip.

Thumbnail (read-only) — provides a thumbnail image of the clip or still. Thumbnails can be enlarged by clicking and 
dragging the right border of the thumbnail column title. Review a flip book playout of the clip by hovering the cursor 
over the thumbnail. The flip book is rendered over a checkerboard pattern so that the alpha channel is visible unless 
the clip is full frame. Still image thumbnails display an icon ( ) indicating that they are still images and not clips.

Flags (read-only) — if using clips that have been transcoded by the XPression INcoder that include tags in the 
filename, this column lists the tags that have been parsed from the filename of the clip. The possible flags include:

• LE — indicates that looping has been enabled.

• HF — indicates that the clip will hold the last frame.

• PM — indicates that the clip uses premultiplied/shaped video.

Audio Ch (read-only) — lists the amount of audio channels embedded in the clip.

Bit Depth (read-only) — lists the quality of the signal quantization for the clip.

Recall ID (read-only) — lists the ID number for the clip when it is recalled.

Project (read-only) — lists the name of the project to which the clip has been added.

Added (read-only) — lists the date the clip was added to the project.

Expires (read-only) — lists the expiry date for the clip, if applicable.

Codec (read-only) — lists the codec format of the clip.

File Ext (read-only) — lists the file type of the clip.

Alpha (read-only) — provides a thumbnail of the clip with the alpha channel visible (requires the original clip to be 
re-ingested or the thumbnail needs to be updated in the Edit Clip/Add Sub Clip dialog box if the original status 
indicates <no info>).

First Frame TC (read-only) — lists the timecode at the point of the first frame of the clip.

Volume (read-only) — lists the volume level of the clip in decibels.

Advanced Search Options

Name — use this box to enter the name of a clip to search.

Recall ID — use this box to enter a recall ID to search.

Source — use this box to enter a location to search for a clip.

ID Min — use this box to enter or select a minimum clip ID number to search.

ID Max — use this box to enter or select a maximum clip ID number to search.

Duration Min — use this box to enter a minimum duration time to search for the clip.

Duration Max — use this box to enter a maximum duration time to search for the clip.

Project — use this list to select a project to search for the clip.

Added Min — use the calendar to select a minimum date to search that the clip was added.

Added Max — use the calendar to select a maximum date to search that the clip was added.

Expires Min — use the calendar to select the minimum expiry date to search for the clip.

Expires Max — use the calendar to select the maximum expiry date to search for the clip.

Never Expires — select this check box to search for a clip with no expiry date set.

Audio Ch Min — use this box to enter or select a minimum amount of embedded audio channels to search for the 
clip.

Audio Ch Max — use this box to enter or select a maximum amount of embedded audio channels to search for the 
clip.

No Audio — select this check box to search for a clip with no embedded audio.
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Reset Filter — click this button to clear all the fields in the Advanced Search Options.

Clip Browser Shortcut Menu

Right-click on a clip in the Clip Browser to access the Clip Browser shortcut menu.

Cue on Server Channel — select this to add the selected clip to the active (focused) server channel.

Edit — select this to open the Edit Clip dialog box and edit the settings of the selected clip.

Add Sub Clip — select this option to open the Add Sub Clip dialog box and create a sub clip from the selected clip.

Set Recall ID — set the recall ID of a selected clip or a range of selected clips in the Clip Browser using the Set 
Recall ID dialog box. Use the Set Recall ID dialog box to enter a recall ID to assign to a selected clip or the starting 
recall ID for the range of selected clips. Using the keyboard shortcut Ctrl + R also opens the Set Recall ID dialog box.

Adjust Loop / Hold Last > Enable Looping — enable looping for a clip or a range of selected clips.

Adjust Loop / Hold Last > Disable Looping — disable looping for the clip or a range of selected clips if looping is 
enabled.

Adjust Loop / Hold Last > Enable Hold Last Frame — hold the last frame of the clip or a range of selected clips 
when playout ends. Do not select this function if taking the clip(s) offline automatically using an out transition.

Adjust Loop / Hold Last > Disable Hold Last Frame — disable holding the last frame of the clip or a range of 
selected clips when playout ends if holding the last frame is already enabled.

Add to Sequencer — add selected clip or range of clips to the Sequencer.

For More Information on...

• the Edit Clip dialog box and Add Sub Clip dialog box, refer to “Edit Clip/Add Sub Clip” on page 6–17.
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Server Channels Interface Overview
The following screen capture displays the main elements of the Server Channels interface.

1) Transitions / Options — use this section to set the in 
and out transitions for the clip in the active server 
channel and configure the options for the active server 
channel.

2) Preview — use this window to preview a clip before 
playout.

3) Server Channel — use this window to view the loaded 
clip and audio monitors and use the playout controls to 
play, pause, skip forward, skip backward, loop, eject or 
move the position of the clip.

1 2
3
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Using the Server Channels
The Server Channels are used in the XPression Sequencer for previewing and playing out clips. The Server 
Channels also allow for editing of clips.

Opening the Server Channels

If using the Clips Option for XPression, use the following procedure to access the Server Channels.

1. In XPression, open the Sequencer layout.

2. In the Menu bar, click Display > Server Channels.

The Server Channels window opens.

Loading a Clip in the Server Channels

 For clips to load in the Server Channels window, server channels must be configured in the Server Channels tab 
of the XPression Hardware Setup.

1. In the Sequencer, use the Menu bar to select Display > Clip Browser.

The Clip Browser window opens.

If clips have been sent to the Clip Browser from the Record Client, or if clips have been transcoded by the 
INcoder into the Watch Folder, clips will automatically load into the Clip Browser.
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2. Drag and drop a clip from the Clip Browser onto a Server Channel in the Server Channels window.

The clip is added to the Preview channel for the Server Channel (or directly to the Server Channel if the 
preview has been disabled in the options).

The clip will be loaded to its pre-configured in point.

If loaded in the Preview, click Take to play the clip on air on the Server Channel. While a clip is on air, clips can 
be cued on the Preview channel while still allowing the on air clip to be controlled and have its timecode and 
countdown visible.

Server Channel playback controls are provided or the space bar can be used to pause and start playback.

A realtime proxy of the clip is shown as it plays in the server channel along with audio meters and a time 
remaining counter.

Take items or timed groups in the Sequencer can also be dragged onto a server channel for playback. To 
preserve the original server channel assignment of a take item, press and hold Ctrl while dragging and dropping 
from the Sequencer to a server channel.

 Clips can also be loaded to a channel by double clicking them in the Clip Browser. They will be loaded onto the 
currently active server channel, as shown by a cyan outline around the channel. Once a clip is loaded to a server 
channel, it can be dragged and dropped from one server channel to another as a duplicate. The active channel 
can be changed by double clicking any other server channel.

Clips can also be dragged and dropped directly from Windows Explorer for situations where the clip is not loaded 
into the Clip Store (or there is no Clip Store present).

For More Information on...

• setting up server channels and virtual outputs, refer to “Set Up Server Channels” on page 6–2.

• sending clips from the Record Client to the Clip Browser, refer to “Send a Video or Image to Clip Store Using 
the Record Client” on page 6–27.

• configuring a Watch Folder for the INcoder, refer to “Configuring the XPression INcoder” on page 5–5.

Server Channels Interface

The following section describes the Server Channels interface.

Transition tab

Use this tab to select and configure the in and out transition for the clip in the selected Server Channel.

Transition 

Use the In and Out tabs to select an in and out transition for the clip.

• Cut — select this to use an instantaneous transition to and from the clip.

• Dissolve — select this to use a gradual transition where a clip dissolves in or out.

• Push — select this to use a sliding transition where the clip pushes in or out.

• Distort — select this to use a transition where a clip is warped in or out.
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Mode 

Use this section to configure the Dissolve, Push, and Distort transition mode.

• Dissolve 

› Fade — select this transition to fade in to, or out from, the clip.

› Over Black — select this transition to fade in or out from black.

› Additive — select this transition to gradually add light to the clip when transitioning in or out.

› Saturate — select this transition to saturate the clip when transitioning in or out.

› Desaturate — select this to transition to desaturate the clip when transitioning in or out.

› Invert — select this transition to invert the clip when transitioning in or out.

• Push 

› Right To Left — select this transition to push from right to left.

› Left To Right — select this transition to push from left to right.

› Top To Bottom — select this transition to push from top to bottom.

› Bottom To Top — select this transition to push from bottom to top.

› Bottom Right — select this transition to push to the bottom right.

› Top Right — select this transition to push to the top right.

› Bottom Left — select this transition to push to the bottom left.

› Top Left — select this transition to push to the top left.

• Distort 

› Diverge — select this transition to use multiple splits in the image in the clip.

› Pixelate — select this transition to pixelate the clip.

› Sine Wave — select this transition to apply a sine wave pattern to the clip.

› Shrink — select this transition to expand the clip from a shrunken image.

› Shrink Diff — select this transition to expand the clip from a shrunken image.

› Spiral — select this transition to spin the clip.

› Duration — use this box to enter or select the duration of the transition in number of frames.

› Reverse — check this box to reverse the selected transition.

Options tab

Use this tab to configure various options for the server channels.

Global Options 

• Display Size — use this list to select a display size for the server channels. The options are:

› Small 

› Large (default) 

Channel Options 

• Cue video clips directly to framebuffer — select this check box to cue clips to air immediately when dropped on 
a server channel from the Clip Browser or Sequencer. This disables the preview channel for the selected server 
channel.

• Show Slate when cued — select this check box to display the clip name and duration when the clip is cued.

• Use preview channel — select this check box to display a preview channel for the selected server channel.

• Use source clip timecode — select this check box to display the timecode from the original source clip when the 
original clip is a .MOV file with a timecode track.

• VITC Output — use this list to output VITC timecode with a clip on the selected server channel. The options are:

› None — do not use VITC timecode.

› Timecode — use the timecode of the clip.

› Remaining — use a countdown timer.
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• Pause Mode — use this list to select to display the frame or field when the clip on the selected server channel is 
paused. The options are:

› <auto> — select this to automatically select the pause mode for a clip. Progressive formats will automatically 
select a frame and interlaced formats will automatically select a field.

› Frame — select this to use a frame on pause.

› Upper Field — select this to use the upper field on pause.

› Lower Field — select this to use the lower field on pause.

Preview

The following section describes the Server Channels preview controls.

Preview (read-only) — displays the image thumbnail for the loaded clip.

 Eject — click this button to remove a loaded clip from the preview channel.

 Take — click this button to take the clip on air over the server channel and remove it from the preview 
channel.

 Auto Take — select this button to automatically take a clip cued on the preview channel when the on air clip has 
finished playing. This button is green when the auto take function is on.

Scrub Bar — click and hold on the marker to drag it forward or backward along the time bar to move the clip position 
to a particular location.

Current (read-only) — displays the elapsed time of the clip.

Remaining (read-only) — displays the time remaining in the clip.

Clip Name (read-only) — displays the name of the clip loaded in the preview channel.

Recall ID (read-only) — displays the recall ID of the clip loaded in the preview channel.

Server Channels

Server Channel X (read-only) — displays the output configured for the server channel, the selected layer, the image 
thumbnail for the loaded clip, and an audio meter.

 Eject — click this button to remove a loaded clip from the server channel.

 Back — click this button to return to the beginning of the clip.

 Pause — click this button to pause the clip.

 Play — click this button to play out the clip.

 Forward — click this button to reach the end of the clip.

 Loop — click this button to continuously play the clip. When this button is green, the loop function is turned on. 
Clicking it again will turn off the loop function.

Scrub Bar — click and hold on the marker to drag it forward or backward along the time bar to move the clip position 
to a particular location.

Current (read-only) — displays the elapsed time of the clip.

Remaining (read-only) — displays the time remaining in the clip.

Clip Name (read-only) — displays the name of the clip loaded in the server channel.

Recall ID (read-only) — displays the recall ID of the clip loaded in the server channel.

Transition (read-only) — displays the transition applied to the server channel.
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Server Channels Shortcut Menu

Right-click on a clip in the Server Channels to access the Server Channels shortcut menu.

Adjust Clip Volume — select this to open the Adjust Clip Volume dialog box and adjust the volume of the clip in 
decibels. Adjusting the volume of a clip on a server channel will adjust the volume of the clip in the ClipStore.

Edit Clip — select this to open the Edit Clip dialog box and edit the settings of the selected clip.

For More Information on...

• the Edit Clip dialog box, refer to “Edit Clip/Add Sub Clip” on page 6–17.
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Edit Clip/Add Sub Clip
Use the Edit Clip and Add Sub Clip dialog boxes to configure metadata for a clip. The Add Sub Clip dialog box has 
the same interface as the Edit Clip dialog box but is used to create a trimmed clip from an existing clip. A video can 
have multiple subclips defined within it, each with distinctive in/out points. Loading a subclip for playout is identical to 
loading a normal clip.

• The Edit Clip dialog box can be accessed from the Clip Browser window and Server Channels window.

• The Add Sub Clip dialog box can only be accessed from the Clip Browser window.

For More Information on...

• opening the Edit Clip window and the Add Sub Clip window from the Clip Browser, refer to “Clip Browser 
Shortcut Menu” on page 6–10.

• opening the Edit Clip window from the Server Channels, refer to “Server Channels Shortcut Menu” on 
page 6–16.

Edit Clip/Add Sub Clip Interface

Video

This section displays the clip that has been selected for editing or creating a sub clip. The clip is rendered over a 
checkerboard pattern so that the alpha channel is visible unless the clip is full frame.

Use the timeline marker to select a specific frame in the timeline.

The video can be scrubbed using the timeline bar; or using common NLE shortcuts like H,J,K to play/rewind at 
different speeds.

During scrubbing audio can be heard by configuring an Audio Monitor device in the Hardware Setup.
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• Right-click inside the Clip, Local Events, or Event Track timeline to access the shortcut menu.

 Event Track timelines are available if global event tracks have been configured in the Clip Store Manager and 
added as a processor in the INcoder. They will appear in the timeline as named in the Clip Store Manager. They 
can be assigned as local events by selecting Preset Event Track > Copy Events to Local Event Track from the 
shortcut menu.

Looping > Set Loop Start — select this option to select the current position of the timeline marker as the start of the 
video loop.

Looping > Set Loop End — select this option to select the current position of the timeline marker as the end of the 
video loop.

Looping > Reset Loop — select this to clear the loop settings.

Clear In Point — select this clear a configured start time for the clip.

Clear Out Point — select this clear a configured end time for the clip.

Clear In and Out Points — select this clear the configured start and end times for the clip.

Update Clip Thumbnail — select this option to update the thumbnail for the clip to reflect any edits or to use a 
specific frame as the thumbnail in the Clip Browser.

Add Event > Rosstalk Event — select this option to directly add a RossTalk event onto the clip timeline.

Add Event > Scene Director Trigger — select this option to directly add a Scene Director trigger event onto the clip 
timeline.

Rename Event — select this option to rename a selected RossTalk or Scene Director trigger event on the clip 
timeline.

Delete Event — select this option to delete a selected RossTalk or Scene Director trigger event on the clip timeline.

 Set In Point — click this button to set the start time of the clip where the timeline marker has been positioned. 
Keyboard shortcut ‘I’ can be used to mark an in point.

 Set Out Point — click this button to set the end time of the clip where the timeline marker has been positioned. 
Keyboard shortcut ‘O’ can be used to mark an out point.

 Move current position to in point — click this button to return to the in point of the clip.

 Start play back — click this button to play back the clip.

 Move current position to end point — click this button to reach the end of the clip.

 Loop — click this button to loop the playback of the clip. Click it a second time to turn off looped playback.

For More Information on...

• looping, refer to “Looping Tab” on page 6–19.

Clip Timing (read-only)

Position — indicates the position of the timeline marker in the timeline for the clip.

In — displays the in point for the clip.

Out — displays the displays the out point for the clip.

Length — displays the total duration of the clip in frames.

Duration — displays the time length of the clip.

Source Information (read-only)

Resolution — displays the video format of the source clip.

Frame Rate — displays the frame rate of the source clip.

File Size — displays the file size of the source clip.

Bit Depth — displays the quality of the signal quantization of the source clip.

Audio Channels — displays the amount of embedded audio channels used in the source clip.
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Codec UID — displays the type of encoding used for the source clip.

Source TC — displays the timecode of the source clip.

Duration — displays the total duration in frames of the source clip.

Clip Tab

Name — use this box to enter or edit a name for the clip.

Recall ID — use this box to enter an ID number for the clip when it is recalled.

Hold Last Frame — select this check box to hold the last frame of the clip when playout ends. Do not select this 
check box if taking the clip offline automatically using an out transition.

 Holding the last frame can be also enabled/disabled in the Clip Browser by right-clicking on the clip and selecting 
Adjust Loop / Hold Last > Enable Hold Last Frame or Disable Hold Last Frame from the shortcut menu.

In Point — use this box to enter a starting point for the clip.

Out Point — use this box to enter an ending point for the clip.

Audio Level — use this box to enter or select a volume level for the clip in decibels. Changing the audio level in the 
Edit Clip dialog box while clip is on air will not affect clip audio on a Server Channel. However, it will be applied to the 
audio monitor if an audio monitor is configured in the Hardware Setup.

Source (read-only) — lists the location where the clip is stored.

File Name (read-only) — lists the name and file extension of the clip.

Project — use this list to select a project for the clip.

Added (read-only) — lists the date the clip was added to the clip store.

Last Modified (read-only) — lists the date the clip was last edited.

Expires — use the calendar to select an expiry date for the clip, if necessary.

Does not expire — select this check box to use no expiry date for the clip.

Looping Tab

Enable Looping — select this check box to enable looping for the clip.

 Looping can be also enabled/disabled in the Clip Browser by right-clicking on the clip and selecting Adjust Loop / 
Hold Last > Enable Looping or Disable Looping from the shortcut menu.

Multi-Point — if looping has been enabled, select this check box to enable the multi-point loop settings.

Multi-Point Loop Settings 

Use the multi-point loops to create free running 4-point and 3-point loops:

• 4-point loops use a frame in point, a loop section of start and end frames, and a frame out point.

• 3-point loops use a loop section of start and end frames with either a frame in point the same as the loop start 
frame or a frame out point the same as the loop end frame.

Loop Start — use this box to enter a starting frame for the loop within the clip time.

Loop End — use this box to enter an end frame for the loop within the clip time.

Loop Count — use this box to enter or select an amount of playbacks the clip will loop before stopping. Use 0 
for infinite looping.

 — click this button to set the start time or end time of the loop at the position of the timeline marker.

 — click this button to skip to the start of the loop.

 — click this button to skip to the end of the loop.

For More Information on...

• creating a 4-point loop, refer to “Creating a 4-Point Loop” on page 6–23.

• creating a 3-point loop, refer to “Creating a 3-Point Loop” on page 6–25.
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Additional

Original File Name (read-only) — displays the original name of the file as uploaded.

Premultiplied / Shaped — select this check box to multiply/shape the fill signal color information by the luminance 
information in the key signal.

Event Tracks

Event tracks are configured in the Clip Store Manager, added as processors in the INcoder, and then available to use 
when editing clips from the Clip Browser. The Event Tracks tab provides a list of available global event tracks.

Assigned Event Tracks — lists the event tracks assigned to the clip.

Available Event Tracks — lists the available event tracks that can be assigned to the clip.

Add Track — select an available event track and click this button to assign it to the clip.

Remove Track — select an assigned event track and click this button to remove it from the clip.

Other

Export — use this list to select one of the following options for exporting a clip:

To Video — open the Export to Video dialog box to save the clip as an AVI or MOV video file. XPression encoded 
AVI video files can also be sent directly to the Clip Store.

Still to Disk — open a save dialog to save a still as a Targa (.TGA), Targa (RLE Compressed) (.TGA), Portable 
Network Graphic (.PNG), or JPEG (.JPG) format image file.

Still to Clipstore — open the Send to Clip Store dialog box to send a still to the Clip Store database to be used within 
the Clips workflow.

Interlaced Settings > Frame Based — select this to capture the image file without deinterlacing. This setting only 
works best for scenes with minimal motion.

Interlaced Settings > Field (line doubled) — select this to capture the image file with each line doubled. For 
example, it will replace field two with a duplicate of field one.

Interlaced Settings > Field (line interpolated) — select this to capture the image file by interpolating between odd 
lines to form even lines.

Save — click this button to save the edited clip or sub clip.

Cancel — click this button to exit the dialog box without saving any changes.

For More Information on...

• the Export to Video dialog box, refer to the XPression Help file.
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Updating the Thumbnail in the Clip Browser
Update the thumbnail in the Clip Browser to provide a more representative or preferred image to illustrate the content 
of the clip.

1. In the Clip Browser, right-click on a clip and select Edit Clip or Add Sub Clip.

The Edit Clip / Add Sub Clip dialog box opens.

2. In the Edit Clip or Add Sub Clip dialog box, move the timeline marker to a desired frame in the timeline.
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3. Right-click inside the timeline and select Update Clip Thumbnail from the shortcut menu.

4. Click Save.

The thumbnail for the clip is updated in the Clip Browser.
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Creating a 4-Point Loop
4-point loops use a frame in point, a loop section of start and end frames, and a frame out point.

1. In the Edit Clip / Add Sub Clip dialog box, click the Clip tab.

The Clip tab opens.

2. In the In Point box, enter a frame in point.

3. In the Out Point box, enter a frame out point.

4. Click the Looping tab.

The Looping tab opens.

5. In the Looping tab, select the Enable Looping check box.

6. Select the Multi-Point check box.
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7. In the Multi-Point Loop Settings section:

a. Use the Loop Start box to enter a frame start for the loop.

b. Use the Loop End box to enter a frame stop for the loop.

c. Use the Loop Count to enter or select a number of times to playout the loop.

8. Click Save.

The edited clip is updated in the Clip Browser.
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Creating a 3-Point Loop
3-point loops use a loop section of start and end frames with either a frame in point the same as the loop start frame 
or a frame out point the same as the loop end frame.

1. In the Edit Clip / Add Sub Clip dialog box, click the Clip tab.

The Clip tab opens.

2. In the Clip tab, enter a frame in point in the In Point box or enter a frame out point in the Out Point box.

3. Click the Looping tab.

The Looping tab opens.

4. In the Looping tab, select the Enable Looping check box.

5. Select the Multi-Point check box.
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6. In the Multi-Point Loop Settings section:

a. Use the Loop Start box to enter a frame start for the loop.

b. Use the Loop End box to enter a frame stop for the loop.

c. Use the Loop Count to enter or select a number of times to playout the loop. Use 0 for infinite looping.

7. Click Save.

The edited clip is updated in the Clip Browser.
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Send a Video or Image to Clip Store Using the Record 
Client
Once a recording or image has been completed in the Record Client, it can be sent to the Clip Store database to be 
used within the Clip workflow.

1. Create a video or image in the Record Client.

2. Right-click on a video or image thumbnail and select Send to Clip Store from the shortcut menu. Multiple 
videos and images can be selected by using Shift + click or holding Ctrl and clicking on individual videos and 
images.

 Only XPression codec clips should be sent to the Clip Store.
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The Send to Clip Store dialog box opens.

3. In the Metadata section, configure the following items:

• Name — enter a new name for the video or image in Clip Store, if necessary.

• Recall ID — enter an identifier to recall the video or image from an external device.

• Project — use this list to select any existing projects from Clip Store or enter a new project name for the video 
or image. New projects are automatically added to the Clip Store.

• Looping — select this check box to infinitely replay the video each time it reaches the end.

• Hold Last Frame — select this check box to freeze the video on the last frame after playing.

• Premultiplied (Shaped) — select this check box to multiply/shape the fill signal color information by the 
luminance information in the key signal.

4. Click Transfer Clip.

The video or image file is transferred to the Clip Store. Once the transfer has successfully completed, the Status 
is listed as Import Complete, the Progress bar is at 100%, and Destination details are listed.

For More Information on...

• using the Record Client, refer to the XPression User Guide or Help file.
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Preset Event Tracks
The Clip Store Manager has the ability to create preset events tracks with RossTalk and Scene Director trigger 
events which can be assigned to clips in the clip editor.

Step 1: Configure the Events in the Clip Store Manager

1. Open the XPression Clip Store Manager.

2. In the Object Browser, select Event Tracks from the Clip Store menu tree.

The Event Tracks section opens in the main window.

3. Click Add to add an event track.

The New Event Track dialog box opens.
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4. In the Track Properties section:

• Use the Name box to enter a name for the event track.

• Use the Description box to enter a brief description for the event track if necessary.

5. Click Add Action and select one of the following as an action for the event:

• RossTalk Event 

• SceneDirector Trigger 

The selected action is added to the Actions list.

6. In the Action Properties section, use the Name box to enter a name for the action.

7. Click Edit Action to configure the properties of the action.

• If a RossTalk action was selected, then the RossTalk Event Properties dialog box opens.

• If a SceneDirector Trigger action was selected, then the Trigger Event Properties dialog box opens.

Configure the selected action:

RossTalk Event

a. In the Properties section, use the GPI Board list to select the GPI board to use for the RossTalk message.

b. Use the RossTalk Msg list to select the RossTalk message to use for the event. For more information on 
individual RossTalk commands, refer to the GPI On XPression app note.

c. Select one of the Execute when activated from play direction options:

• Left & Right — select this option to execute the event when the play direction of the track is moving left or 
right.

• Left — select this option to execute the event when the play direction of the track is moving left only.

• Right — select this option to execute the event when the play direction of the track is moving right only.
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Trigger Event

 The Trigger in this scene only check box is not supported with event tracks.

a. In the Properties section, use the Scene Name box to enter the name of the scene with the Scene Director 
to trigger in other on-air scenes. The wildcard character (*) is supported.

b. Use the Scene Director box to enter the name of the Scene Director to trigger from the selected scene(s).

c. Select an Action for the Scene Director when triggered:

• Play — playout the tracks in the Scene Director.

• Play Reverse — playout the tracks in the Scene Director in reverse.

• Pause — pause the tracks in the Scene Director.

• Stop — stop the tracks in the Scene Director.

• Play Range — select this to set a play range in frames for the playout. Use the boxes to enter or select 
the play range in frames.

d. Use the Framebuffer list to select the framebuffer on which the scene will be triggered.

e. Select one of the Execute when activated from play direction options:

• Left & Right — select this option to trigger the Scene Director when the play direction of the track is 
moving forward or in reverse.

• Left — select this option to trigger the Scene Director when the play direction of the track is moving 
forward only.

• Right — select this option to trigger the Scene Director when the play direction of the track is moving in 
reverse only.

8. Click OK.

The RossTalk Event Properties or Trigger Event Properties dialog box closes.

9. In the Timing Options section, use the Time Offset box to enter or select a number of frames to offset the 
event and select a Reference Point for the offset:

• From Beginning — apply the time offset from the beginning of a clip.

• From Middle — apply the time offset from the middle of a clip.

• From End — apply the time offset from the end of a clip.
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10. Click OK.

The New Event Track dialog box closes and the event is added to the Event Track list.

Step 2: Assign the Event Track to a Processor in the INcoder

 INcoder must be configured and connected to the Clip Store before proceeding with this procedure. For more 
information on configuring INcoder, refer to the XPression INcoder User Guide.

1. In XPression INcoder, click the Configuration tab.

The Configuration section opens.

2. In the Configuration section, click the Processors tab.

The Processors tab opens.
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3. Select a processor from the Processors list.

4. In the Targets section of the selected processor, select the Clip Store that includes the configured event track(s).

The Clipstore Options (ClipStore) section is displayed.

5. In the Clipstore Options (ClipStore) section, click Add.

The Add Event Tracks dialog box opens.
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6. Select an event track from the list and click OK.

The selected event track is added to the Assigned Event Tracks list in the Clipstore Options (ClipStore) 
section.

7. Click the Sources tab.

The Sources tab opens.

8. Select a source from the Sources list.

9. Use the Processors list to select the processor that contains the assigned event track(s).

10. Click OK.
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Step 3: Add an Event Track to a Clip

1. In the Clip Browser (or a Server Channel) in XPression, right-click on a clip and select Edit from the shortcut 
menu (or press F8).

The Edit Clip dialog box opens.

2. Click the Event Tracks tab.

The Event Tracks tab opens.
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3. In the Event Tracks tab, select an event track from the Available Event Tracks list and click Add Track.

The event track is added to the Assigned Event Tracks list and appears as an event track in the clip timeline.

Event tracks can be unassigned by selecting the event track in the Assigned Event Tracks list and clicking 
Remove Track.

An event track in the clip timeline can be assigned to the clip as a local, editable event by right-clicking on the 
event in the Event Track timeline and selecting Preset Event Track > Copy Events to Local Event Track. A 
prompt will give the option to keep the original event track or delete it from the timeline. The event will appear in 
the Local Events timeline once added. The original event track can be added back to the clip anytime by 
reassigning it through the Event Tracks tab.
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PBus
The following topics are discussed in this section:

• PBus Overview

• Configuring PBus and PBus Recalls

• PBus Triggers

• PBus LEARN Commands

• PBus Mapping

• Using PBus from a Switcher to Recall Items

• Using PBus for XPression Clips
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PBus Overview
PBus (Peripheral Bus) is an industry standard protocol designed to allow production switchers to communicate with 
external devices. Most large production switchers have some capability of sending PBus commands to a device.

XPression supports PBus over standard RS232 or TCP/UDP sockets.

The chassis of some turnkey XPression systems might not include a standard RS232 port. However, it is possible to 
use an RS232-USB adaptor.

If the production switcher has an RS422 serial port, then you will require an RS232-RS422 adaptor. This adaptor will 
require its own power supply. Generally, the adaptors that are port-powered will not function for these purposes.

 On an XPression Bluebox system, a limited subset of PBus functionality is available. PBus commands can be 
used to trigger take items that have been pre-built in an XPression sequence using either XPression Designer or 
Studio. It is not possible to customize the PBus registers actions using Bluebox. Each register number 
corresponds to a specific take item number and can not be changed. It is not possible to load the PBM or PBMS 
PBus mapping files on Bluebox.
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Configuring PBus and PBus Recalls
Use the Hardware Setup to configure XPression to accept PBus commands. PBus is an industry standard protocol 
designed to allow production switchers to communicate with external devices.

To enable XPression to accept PBus commands:

1. In XPression, click Edit > Hardware Setup.

The Hardware Setup dialog box opens.

2. Click the GPI Boards tab.

3. Click Add.

The Add New GPI Board dialog box opens.

4. Use the Brand list to select PBus.

5. Click OK.

The PBus Setup dialog box opens.
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6. In the Settings section, select Enabled from the State list. Select Disabled to turn off PBus.

7. Select a Mode for PBus:

• Serial RS232 — select to use RS232 to send PBus signals to XPression. 

• TCP — select to use TCP/IP to send PBus signals to XPression. 

• UDP — select to use UDP sockets to send PBus signals to XPression. 

8. Configure the selected mode:

RS232 GPI Settings

a. Use the Port list to select the Communication port that receives the signals.

b. Use the Baudrate list to select the communication speed for the signals.

c. Use the Data Bits list to select the number of bits used to represent one character of data for the signals.

d. Use the Parity list to select the method used to check for lost data in a signal.

e. Use the Stop Bits list to select the number of bits used to indicate the end of a byte in a signal.

f. Use the Flow Control list to select the data transmission rate controller for a signal.

The flow control can be set to Hardware or None, but it must be set the same in both XPression and the 
transmitting device. 

TCP & UDP

a. In the Network Settings section, use the TCP Port/UDP Port box to enter or select the communication port 
that receives the signals.

9. In the PBus Options section, configure the PBus recall options.

XPression normally does not perform any action when a PBus recall command is issued. Instead, it stores the 
recall ID to be used later when a PBus trigger command is issued.

Configure the following PBus recall options:

•  Clear layer on recall — when this option is selected and a PBus recall command is received, XPression will 
look to see which channel and layer that the take item being recalled has been assigned. It will then 
immediately clear that layer and channel. However, the take item will not be read to air until such time as a 
PBus Trigger command is received to put the item on air. This configuration option is recommended to be 
enabled in situations where XPression might be used to play back clips/graphics and to ensure that as soon 
the recall command is issued, any previous graphic that might have been left over on the layer will be 
removed.

• Move sequencer focus on recall — this configuration option can be selected to move the sequencer focus 
to the item that is being recalled. This can be useful as a means of generating a preview output that will show 
a rendered frame from the item that will be put on air when the PBus trigger command is received.

• Cue item on recall — selecting this option will place the take item into a cued state when the recall command 
is received. This is useful when using video clips which might take a few frames to cue.

• Video Clips cue directly to framebuffer — selecting this option will cause the video clips from the Clip Store 
that are assigned to a PBus register to cue directly onto the hardware output of XPression in a paused state. 
When the play command is received, they will begin playing.

• Ignore LEARN command — selecting this option will ignore the LEARN command. LEARN stores the clip 
currently loaded into a server channel into the PBus register list when the LEARN command is received.

10. Use the Data Logger list to select an encoding scheme for the data log. The options are:

• None — select this option to use no data logging.

• ASCII — select this option to use ASCII encoding for the data log.

• HEX — select this option to use HEX file formatting for the data log.

• Both — select this option to use both ASCII encoding and HEX file formatting for the data log.

11. Click OK.

The PBus interface is displayed in the GPI Board list.

12. Click Close.

The Hardware Setup dialog box closes.
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13. Click OK.

The PBus Setup dialog box closes and the new PBus interface is added to the GPI Boards table.

For More Information on...

• configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.



7–6 XPression Clips Workflow User Guide (v11.0)

PBus Triggers
XPression supports many PBus Trigger commands.

• Trigger 0 – Play Item 

 This trigger can be overridden in the PBus mapping.

Trigger 0 is normally used to play a take item to air. However, this can be overridden to perform other actions on a 
per-register basis. These actions can be configured in the PBus mapping menu.

• Trigger 1 – Take Sequence Item Off-Air 

Trigger 1 is used to take an item off air (assuming it was already on air). The item taken off air will be the take item 
that was previously recalled using a PBus recall command.

• Trigger 2 – Execute GPI 

Trigger 2 is used to emulate a standard GPI input. In the XPression Keyboard/GPI Mapping, various actions can 
be configured to be executed on a GPI input being triggered. It is possible to trigger up to 99 different GPIs 
through PBus. The GPI number that will be triggered is the number that was previously recalled using a PBus 
recall command.

• Trigger 3 – Clear Framebuffer 

Trigger 3 will clear the framebuffer assigned to the device in the PBus channel configuration. If the channel is set 
to <default>, this trigger will clear Channel 1.

• Trigger 4 – Clear Framebuffer Channel 2 

Trigger 4 will clear the framebuffer assigned to the device in the PBus channel configuration. If the channel is set 
to <default>, this trigger will clear Channel 2.

• Trigger 5 – Read Current Sequence Item to Air 

Trigger 5 will take the currently selected sequence item from the sequencer to air. It ignores the PBus recall 
command and uses whichever item currently has focus in the XPression sequencer.

• Trigger 6 – Resume Channel 

Trigger 6 will resume all paused graphics currently on the framebuffer assigned to the device in the PBus Channel 
Configuration. If the framebuffer is set to <default>, this will resume Channel 1.

• Trigger 7 – Resume Channel 

Trigger 7 will resume all paused graphics currently on the framebuffer assigned to the device in the PBus Channel 
Configuration. If the framebuffer is set to <default>, this will resume Channel 2.

• Trigger 8 – Resume Take Item 

Trigger 8 will resume a single paused take item. The take item will be the item previously recalled by a PBus recall 
command.

• Trigger 10 – Bank 0 

Trigger 10 will change the last recall command into an ID in the 0-99 range (refer to the Bank 1 command below 
for more details).

• Trigger 11 – Bank 1 

Trigger 11 is used to allow switchers that can only send PBus recall commands up to 99 to be able to recall take 
items with values of between 100 and 199.

This “bank 1” command will add 100 to the last recalled item using a PBus recall command. For example; to recall 
take ID 135 and put it on air, a switcher could send:

› Recall 035

› Trigger 11 (changes the 035 into 135)

› Trigger 0

It is not necessary to switch back to bank 0 after sending a bank 1 command. XPression will automatically revert 
to bank 0 for the next PBus recall command.

• Trigger 12 – Bank 2 

Changes the last PBus recall command into an ID in the 200-299 range.
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PBus LEARN Commands
When a PBus LEARN command is received from a remote device, XPression will look to the configured server 
channel for the PBus device, and if there is a clip currently cued on that server channel it will assign that clip into the 
PBus register.

There is an option Ignore LEARN command in the PBus Setup dialog box in the Hardware Setup. This option is 
useful if you are manually assigning clips to PBus registers and you do not want to change/overwrite them when 
storing memories on the production switcher. Most production switchers automatically send the PBus LEARN 
command when storing the memory.

For More Information on...

• the PBus LEARN command, refer to the appropriate switcher documentation.
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PBus Mapping
A PBus Mapping menu exists in XPression to provide additional capabilities to the PBus recall system.

Configuring PBus Mapping

Use the PBus Device Configuration dialog box to configure the Device IDs and channels.

To configure PBus Mapping:

1. In XPression, open the Sequencer.

2. Click Display > PBus Mapping.

The PBus Mapping window opens.

3. Click the Setup Device Configuration ( ) icon.

The PBus Device Configuration dialog box opens.
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4. Click Add to add a Device ID.

A device ID is added to the PBus Device Configuration list. At least one Device ID must be added. The Device 
ID is the ID number that will be sent in PBus messages transmitted from the production switcher.

5. Click inside the Device ID column of the ID and enter or select an ID number.

PBus Device IDs must be between 0 and 23.

6. Click inside the Name column of the ID and enter a name to refer to the Device ID. For example, Device A.

7. Click inside the Server Channel column of the ID and use the list to select a specific output framebuffer or use 
the <default> framebuffer.

If the framebuffer is set to anything other than <default> when a PBus recall command is received for a specific 
Device ID, then the item will be played on the selected framebuffer. If <default> is selected, then the item will be 
played on the framebuffer for which the original take item was configured. When a clip from the Clip Store is 
assigned to a register and <default> was selected for the Server Channel, the first device configured will use 
Server Channel 1, the next will use Server Channel 2, etc.

If XPression does not have the Clip Server option, then the Server Channel configuration column will be missing 
and all take items will be cued to the channel assigned to them through the Sequencer.
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8. Click OK.

The Device IDs are added as tabs at the bottom of the PBus Mapping window under the assigned device 
names. If there are no tabs added, then a Device ID was not added to the PBus Device Configuration list.

Assigning an Action to a PBus Register

Each Device has a list of 4095 registers which can be recalled through PBus.

 Some switchers can only support the first 99 registers.

Each PBus register can be assigned an action that will be executed after the register is recalled and Trigger 0 is 
received. The default action for each register is to play the corresponding Take Item with the same number as the 
PBus register.
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To assign an action to a PBus register:

1. In the PBus Mapping window, select a function from the actions list to the right of the devices.

2. Drag and drop the action onto a register.
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The action is added to the register.

Remapping a PBus Register

To remap a PBus register to play a different take item, the take item can be dragged and dropped from the sequencer 
onto the register in the PBus Mapping window or you can enter or select a different take ID using the Take ID box in 
the Recall Take Item section of the PBus Mapping window.

To remap a PBus register using drag and drop:

1. In the Sequencer, select a take item from the Take ID list.
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2. Drag and drop the take item onto a register.

The take item is added to the register.
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To remap a register using the Take ID box:

1. In the PBus Mapping window, select a register number from the devices to the left of the actions list.

2. In the Recall Take Item section, use the Take ID box to enter or select a take item to add to the selected 
register.

The take item is added to the selected PBus register.
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Loading and Saving Maps

PBus maps are not loaded and saved with XPression projects. They are loaded and saved to disk as .pbm or .pbms 
files using the PBus Mapping window. The .pbm file extension is used for a single PBus map and the .pbms file 
extension is used for multiple PBus maps.

Use the following PBus Mapping window toolbar icons to load and save PBus maps:

Load ( ) – click this button to open a file browser to select a PBus map or multiple PBus maps to load.

Save All ( ) – click this button to save multiple PBus maps to disk.

Save ( ) – click this button to save a single PBus map to disk.
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Using PBus from a Switcher to Recall Items
 Consult the switcher documentation for a complete description of how to use PBus with your particular 

manufacturer/model. This section is only intended to provide some background information and tips.

Normally switchers will send a PBus recall command when an EMEM is recalled. The following procedure is an 
example using take item 0005.

To recall and play a specific take item from XPression:

1. In XPression, use the Sequencer to create a take item and give it an ID of 0005.

2. Create an EMEM/Memory on the switcher and store it as EMEM 5.

3. Within EMEM 5, ensure that you have enabled the sending of PBus commands.

4. Within the timeline for EMEM 5, issue a PBus Trigger 0 command.

When EMEM 5 is recalled, it will send a PBus recall 5 command to XPression. This command will not yet do anything 
(unless the configuration options discussed in the Configuring PBus and PBus Recalls section are enabled).

When the timeline is run, the switcher will send a PBus Trigger 0 command. At this time, XPression will then put take 
item #5 on the output channel/layer previously assigned to that item in the sequencer.

 There may be several frames of delay between issuing the Trigger 0 command and when the video for the item 
appears on the SDI output of XPression. This is normal and should be accounted for inside of the timeline on the 
switcher. For example, you will need a delay between the issuing of trigger 0 and when the keyer containing the 
XPression is keyed onto the PGM output.

To recall different take items, the timeline on the switcher can be copied into different switcher registers.
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Using PBus for XPression Clips
Firstly, the PBus configuration must be set to assign a PBus device ID to a specific server channel. This controls the 
server channel onto which PBus commands to a device will load the clip. Valid device IDs are from 0 to 23.

By default, every PBus register (0 to 4095) will cue/play the corresponding take item with that ID number. However, 
clips from the Clip Browser can be assigned to a PBus register simply by dragging them from the Clip Browser onto 
a PBus register. Alternatively, various actions (same ones accessible in the keyboard mapping menu) can be 
assigned to a PBus register by dragging them from the action list on the right to a PBus register. This is useful for 
assigning scripts or actions like Take Next/Clear Channel, etc. to a PBus register. Right-click on a register with a clip 
and select Find Clip in Clip Browser to find a clip or select a different clip in the Clip Browser.

A PBus register map can be saved to disk to a file using the .PBM extension, or maps for all devices can be saved to 
a .PBMS file. Maps can be loaded from these PBM files or from a specific format of XML file. When using the XML 
file import, it will assign clips to PBus registers using their recall ID from the clip database.

Using PBus for XPression Clips with Recall IDs

The PBus map contains a column named Recall ID.

If a clip in the Clip Store exists with that recall ID, it will be assigned to that PBus register. A clip’s recall ID can also 
be entered into the column to assign it to the respective register. The PBus register will always recall the clip with that 
specific recall ID, so if a new clip is ingested with a matching recall ID, the PBus register will recall the new clip 
instead. If the clip is manually edited and the recall ID is changed or removed, the PBus register will no longer recall 
that clip.

A similar behavior exists when dragging a clip with a recall ID into the PBus register; meaning that the PBus register 
is bound to a specific recall ID and not to a specific clip. Holding Ctrl-Shift and dragging a clip onto a PBus register 
will link the clip with the PBus register, and it will not be replaced regardless of a clip with a duplicate recall ID being 
ingested.

For More Information on...

• PBus, refer to the XPression User Guide or Help file.
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Contact Us

Contact our friendly and professional support representatives for the following:

• Name and address of your local dealer

• Product information and pricing

• Technical support

• Upcoming trade show information

Visit Us

Visit our website for:

• Company information and news

• Related products and full product lines

• Online catalog

• Testimonials

Technical        
Support

Telephone:

1-844-652-0645 
(North America)

+800 1005 0100 
(International)

After Hours Emergency: +1 613 • 349 • 0006

Email: techsupport@rossvideo.com

General     
Information

Telephone: +1 613 • 652 • 4886

Fax: +1 613 • 652 • 4425

Email: solutions@rossvideo.com

Website: http://www.rossvideo.com
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